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About this release 

New in this release 

Sametime, Sametime Mobile 

New features in IBM Lotus Sametime  7.5.1 
The following list represents an overview of the new features that are available in IBM Lotus Sametime 
7.5.1. Many Software Problem Report (SPR) issues from earlier Sametime 7.5 releases have also been 
addressed in this release. For additional information about new features, please refer to the product 
documentation, and to the Documentation Updates chapter of these release notes. 

Sametime Connect Client 

z	 Macintosh platform support 

z	 Desktop Single Sign On support in Windows 

z	 Microsoft Office Integration support 

z	 Support for silent install 

z	 The Sametime server is, by default, case-sensitive; now it can be configured to be case-insensitive. 
Case-insensitive ID comparison allows IM awareness in Domino Web Access and Portal.  Please 
see "Case insensitive ID compare" in the Configuration section of these release notes for more 
information. 

z	 The Sametime server can be configured so that no external users are allowed to watch internal 
users.  By default, the Sametime server allows external users to watch internal users.  Please see 
"Internal user consent for external users" in the Configuration section of these release notes for 
more information. 

z	 Ability to designate Primary Buddies in your buddy list 

z	 Improved "Add Contact" dialog 

z	 One-on-one video chat 

z	 Chat History - Added support for recording history of N-way chats as well as searching through chat 
history text 

z	 Improved chat management, using tabbed chats 

z	 Additional policies for better administrator control over client features 

z	 Partial name search for users and public groups. Users can now type a prefix of a group name, or 
the first or last name of a user, and receive a list of relevant matches.  Note that this option may 
generate some additional load on the server.  Please refer to "Disabling partial search for users or 
public groups" in these release notes for details about the option to revert back to the previous 
search method 

1 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

Sametime Mobile 

z	 Sony Ericsson P990/M600 support 

z	 BlackBerry 8100/8800 support 

z	 Lotus Mobile Connect integration 

z	 Quick search with LDAP directory integration 

z	 HTTPS proxy support, including standard HTTP 401 and Lotus Mobile Connect authentication 

z	 Location awareness support 

Sametime Meetings 

z	 Support for Macintosh 

z	 Log-in using fields directly in the meeting center 

z	 Ability to turn off group chat for meetings 

z	 Ability to prevent people from chatting in meetings by setting a policy 

z	 Quicker meeting startup 

z	 Fully resizable sections in the meeting room 

z	 Edge-to-edge maximization 

z	 More efficient presenter transitioning ("Click to Present" has been renamed to "Start Presenting") 

z	 Additional right-click menu options 

z	 Multi-select capabilities in the participant list 

z	 IP audio request mode 

z	 Additional APIs, SPIs, and extension points to support video integration with Sametime Connect 

z	 Microsoft Outlook integration 

Sametime Server 

z	 Linux server support 

z	 Improved reconnection to LDAP server when SSL LDAP connection has been closed 

z	 Broad LDAP configuration support from installation 

z	 Case-insensitive ID comparison on the server and toolkit, allows IM awareness in Domino Web

Access, Portal, and other Sametime-enabled applications


z	 MUX performance improvement on AIX.  In previous releases, MUX inefficiently handled large 
numbers of clients inefficiently with a high CPU usage, and response times would lag.  Note, the 
minimal VRMF for this performance fix is AIX 5.3.0.30, which is covered by the minimum Technical 
Level 5 AIX requirement. 

z	 Enhanced chat logging API allows binary data logging 

z	 A configurable preferred log-in list allows administrators to define the order in which applications will 
handle interactions from another Sametime client.  For example, connect the Sametime client first, 
then Notes, then Meetings.  See technote #1253176 for additional details 
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z	 Resolve Statistics.  The StStatistics server application now outputs Resolve statistics.  The 
Resolve application calculates statistics data, and sends it to the StStatistics application, which 
writes the data to a file.  The Resolve application collects the following statistics parameters for 
different client types and versions logged in to the community. 

The StResolve application sends its response in the form of an XML string which is divided 
according to client types and versions. Please refer to "Collecting Resolve statistics" in these 
release notes for details about how to collect these statistics 

z	 The UserInfo service for 7.5.1 will be able to retrieve users' details from additional Notes databases 
other then the NAB that Sametime is configured to work with for Domino configuration. 

This new feature enables a query of users' details from a Notes database without having to add it to 
the da.nsf database, an operation which may create additional load on the server.  Please refer to 
the Sametime Administrator's Guide for full setting instructions for this feature 

Limitations - Beta release 
Please note the following limitations in the current beta release.  References in the product documentation 
or these release notes that contradict these limitations are incorrect, and should be ignored: 

z	 Server upgrades are not recommended; perform a clean server installation 

z	 It is recommended that the Sametime beta client be installed on a separate machine from any 
Sametime production client version 

z	 STMobile is no longer a separate add-on 

z	 Conversion Services installation is only needed for non-Windows environments, and is not part of 
this beta release 

Backward compatibility 

Sametime 

Buddy list synchronization between 7.5.1 and pre-7.5 clients 
The Sametime 7.5.x client buddy list uses a new XML format in order to support multiple communities and 
group nesting. Additionally, the 7.5.x buddy list is stored in a different location from the pre-7.5 buddy list.  
For the first time user, the pre-7.5 buddy list is automatically imported and converted into the new format.  
Thereafter, the pre-7.5 list can be manually imported into the new client as needed.  Additionally, 
Sametime 7.5.x supports exporting the buddy list into the pre-7.5 .dat file format.  Despite this, users of 
Sametime 7.5.x may be confused to learn that the list they see in non-7.5.x clients is different from the 
one used by the 7.5.x client.  Furthermore, existing applications such as Notes Sametime client uses the 
pre-7.5 Sametime buddy list format.  Sametime 7.5 CF1 and later supports synchronization between the 
pre-7.5 and 7.5.x Sametime buddy list formats. 

Summary

The Sametime 7.5 CF1 and later clients automatically keep the pre-7.5 and 7.5.x contact lists in synch, 

using the following rules:


z	 After logging into the default community with 7.5.x, the pre-7.5 buddy list is automatically imported. 

z	 Each time the 7.5.x buddy list is saved, a pre-7.5 version is generated and saved. 

z	 The first time the two buddy lists are synched, both lists are additively merged. 
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z	 Updates made to the pre-7.5 buddy list appear in realtime in a running 7.5.x client, and vice versa. 

z	 After the initial additive merge, deleting a person or group from pre-7.5 deletes the person or group 
from the 7.5.x list and vice-versa. 

Limitations 

z	 In case users happen to assign group names that are seperated by two semi-colons, the 7.5.x client 
will not import them as nested groups unless the parent group implied by the naming happen to exist.  
In this manner a user can even create nested groups for 7.5.x using the pre-7.5 client.  For example, 
using a pre-7.5 client, creating the groups "test" and "test::subgroup" will result in a new group "test" 
and a new subroup of test called "subgroup" in 7.5.x.Changes between the two lists cannot flow 
wholesale from one to the other, since the formats are different.  Specifically, the 7.5.x list contains 
users from multiple communities, as well as hierarchical groups which do not translate into the pre-7.5 
list. 

z	 Users and public groups not from the default community are not stored to the pre-7.5 buddy list.  For 
example, in the 7.5.x screenshot below, the group "LWP AB" and the person "Konrad Lag" are not 
from the default community and therefore are not exported as part of the pre-7.5 buddy list. 

Sametime 7.5 Sametime pre-7.5 
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z Nested groups are stored using the following format "<group>::<subgroup>".   For example the Work 
subgroup "sametime team" is stored as "Work::sametime team" in pre-7.5. 

Sametime 7.5 Sametime pre-7.5 

In this example the Sametime team subgroup's subgroup "developers" is stored as "Work::sametime 
team::developers" in pre-7.5. 

Sametime 7.5 Sametime pre-7.5 

z	 In case users happen to assign group names that are seperated by two semi-colons, the 7.5.x client 
will not import them as nested groups unless the parent group implied by the naming happen to exist.  
In this manner a user can even create nested groups for 7.5.x using the pre-7.5 client.  For example, 
using a pre-7.5 client, creating the groups "test" and "test::subgroup" will result in a new group "test" 
and a new subroup of test called "subgroup" in 7.5.x. 
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Product compatibility 

Sametime 

Installing Sametime 7.5.1 integration with Microsoft Office 
This release note document outlines the steps involved to properly install IBM Lotus Sametime 7.5.1 with 
Microsoft Office, so you can collaborate, create meetings, and chat with co-workers through IBM Lotus 
Sametime from Microsoft Office.  

Installation 

Platform support 
Windows XP Service Pack 2 with MS Office 2003. 

Uninstalling the Alpha Build 
Perform the following steps to remove the Alpha build. 

z	 Use the Add/Remove Programs, Start -> Settings -> Control Panel -> Add or Remove Programs, on the 
two Alpha entries "OfficeWCAddinSetup" and "OutlookSametimeAddInSetup" 

z	 Go to the windows\system32 directory and run "regsvr32 /u sthelper.dll" 

z	 Delete sthelper.dll and the stonlinemeeting.oft file from the windows\system32 
directory. 

Note:  Other dependency files -- = wmqtt.dll, and the multiple win32 dll dependencies -- can be left intact.  

After completing the above, the installation can be performed. 

Installing Microsoft Office 
Ensure that you have installed the Microsoft Office products that you want to integrate with Sametime.  
The Sametime Toolbar and Web Conferencing functions are additions to Microsoft Outlook, while the 
Microsoft Office Smart Tags are features used in Word, Excel or PowerPoint.  Smart Tags are visible with 
the products you have installed.  Also, set up MS Outlook e-mail accounts with e-mail addresses that can 
be resolved through Sametime. 

Installing Sametime Integration with MS Office 
The 7.5.1 installer is available and handles the installation of the Office Integration components.  

1.	 Copy the following three files from the installer distribution into your working directory: 
sametime-connect-win-7.5.1.exe

sametime751_OI_setup.bat

vcredist_x86.exe


2.	 Run the sametime751_OI_setup.bat batch file.  This executes the vcredist_x86.exe 
package, which installs the Visual C++ runtime prerequisites, and then runs the main Sametime 
installer with the command-line switches needed to enable the Office Integration features. 
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3.	 During installation, the following dialog appears.  All three Office Integration features are selected by 
default.  De-select the feature or features you do not want to install. 

Note:  Uninstall works via Add/Remove Programs.  Additionally, the Microsoft Visual C++ runtime can 

also be uninstalled separately from Add/Remove Programs. 


Known issues 

z	 The WebConference integration feature can support Sametime meeting servers that require SSL by 
modifying the syntax of the server name specified in the Sametime Meeting properties:  if SSL is 
required, include the protocol portion of the server URL, for example " 
https://sametime.mycompany.com".  The syntax shown in the dialog example, 
"sametime.mycompany.com", is correct for servers that are accessible by ordinary, non-SSL http. 

z	 If the default email fields read by the Outlook Toolbar are not the appropriate fields for a customer's 
enterprise, the Toolbar can be redirected to use other fields instead by modifying the file 
CustomProperties.ini in the Sametime install folder.  The intent is that such modifications would be 
made by IT experts and the ini file (text) be distributed to end users.  If this optional file is not present, 
Toolbar uses its default field settings. 
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Limitations 

z	 The local Outlook user email address must be resolvable in Sametime for the MyStatus button to 
properly display status. 

z	 The Web Conference Integration feature is not included in a meeting request that begins from 
Outlook's "Plan A Meeting" dialog. 

z	 In a meeting which includes a Sametime meeting, if the Sametime meeting password is changed after 
the initial invitation is sent, then the message body will show more than one password -- the most 
recent password assignment is displayed last. 

z	 Use of Office Integration features in Outlook 2000 can cause macro warning dialogs to be displayed. 

Third Party Limitations 

The Office Integration features can be uninstalled by uninstalling Sametime.  Outlook will cache and retain 
forms despite the uninstall if the form is designated to be used.  To fully uninstall and eliminate the ST 
OnlineMeeting, ST OnlineMeetingRTL, and STContact custom forms, the user must be sure to set 
Calendar and Contact "When posting..." properties back to IPM.Appointment and IPM.Contact 
respectively. 

Sametime 

Sametime 7.5.1 integration with Microsoft Office 
This release note document contains information on how to use IBM Lotus Sametime 7.5.1 with Microsoft 
Office, so you can collaborate, create meetings, and chat with co-workers through IBM Lotus Sametime 
from Microsoft Outlook.  The features available in this release of Sametime are: 

z	 Sametime Toolbar in Microsoft Outlook  -- The name of the sender of a highlighted message 
appears on the Contacts button of the Sametime toolbar.  The icon on the button shows the 
availability of that person.  Choosing the "Chat" button or selecting the "Chat" command from the 
drop down initiates a Sametime chat. 

z	 Sametime Web Conferencing Integration with Microsoft Outlook  -- A new tab has been added to 
the Calendar dialog of Outlook which allows you to schedule web conferences.  You can create, 
change, and delete Sametime web conferences through the Calendar feature within Outlook.  
The meeting information is sent to you electronically in a meeting invite. 

z	 Sametime task menu in Microsoft Office Smart Tags -- Initiate chats from within a Word, Excel, or 
Power Point document. 

8 
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Initializing Sametime within Microsoft Outlook 

To view the Sametime tab within web conferencing, perform the following steps within MS Outlook. 

1.	 Select the Go menu, then Folder List. 
2.	 In the folder list, right click on the Personal Folders/ Calendar folder and select Properties at the 

bottom of the popup menu. 
3.	 The Calendar properties dialog box appears. Select ST Online Meeting from the When posting to 

this folder, use: drop down list.  Click OK. 

Features 

Sametime Toolbar in Microsoft Outlook 

A new toolbar is added to Outlook, which hosts the Chat and Voice commands, as well as an icon for 
displaying the current status of the currently-selected contact. 

In this example, an e-mail sent by Carolyn Sullivan is currently highlighted in the Inbox -- she is the 
"currently selected sender" because this is her mail item. 
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Note:  In the Contacts view Carolyn Sullivan would be the currently selected contact

 QuickFind - Allows you to launch the Sametime QuickFind dialog allowing you search for 
individuals.  Start typing the name of the person you are searching for, you can search by first or last 
name and then press ENTER.

  Open Sametime Contact List - Selecting when Sametime is running will make Sametime the 
currently active and focused window, restoring it from minimized if needed.  Selecting when Sametime is 
not running will launch Sametime.

  Chat - Allows you to launch a chat with the currently selected sender.  In this example, Carolyn 
Sullivan.  
Note:  Provided the currently selected sender is a Sametime partner who is on-line and not <Do Not 
Disturb>. 

10 
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  Voice Chat - Allows you to launch a voice chat with the currently selected sender.  In this example, 
Carolyn Sullivan.  
Note:  Provided the currently selected sender is a Sametime partner who is on-line and not <Do Not 
Disturb>.

 Phone - Allows you connect via a phone line with the currently selected sender.

  Current Person -  The name and presence of the currently selected sender 
appears.  The drop down menu allows you to select from <Chat>, <Voice> or <Phone>.

  My Presence - Your Sametime availability appears and allows you to 
control your Sametime status from within Outlook.  If you change your presence from the toolbar in 
Outlook to <I am Away> this status reflects in the Sametime client. Also, if you change your status in the 
Sametime client, the status is updated in the Outlook toolbar.

 Help - Allows you to access the Sametime integration with Microsoft Office documentation. 

IBM Sametime Web Conferencing Integration with Microsoft Outlook

The IBM Sametime Web Conferencing Outlook add-in seamlessly integrates IBM Sametime Web

Conferencing with Microsoft Outlook. This pairing provides an easy to use, comprehensive solution for 

facilitating corporate on-line meetings. 


Meetings are scheduled though the familiar Microsoft Outlook Calendar interface. The IBM Web 

Conferencing add-in provides an additional tab on the Outlook Meeting Request Dialog. This additional

tab contains a dialog that is used to specify IBM Web Conferencing information.


Creating a new IBM Sametime On-line Meeting

To create a new IBM Sametime On-line Meeting, start Microsoft Outlook and select the Calendar tab. 

Then use the toolbar to select New | Meeting Request.
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When the “New Meeting” dialog appears you will notice an additional tab labeled “Sametime”. This tab 
contains a dialog where you will enter additional IBM Sametime On-line Meeting information. 

In order to make this meeting an IBM Sametime On-line Meeting, check the “Include an IBM Lotus 
Sametime Meeting” checkbox. You can make this check box always checked by default in the “Meeting 
Options” dialog (link to Meeting Options). 

When you check the “Include an IBM Lotus Sametime Meeting” checkbox, you will notice the other 
controls on the dialog become enabled. You may use these controls to specify additional IBM On-line 
Meeting parameters. 
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Meeting Chair 
Below the “Include an IBM Lotus Sametime Meeting” checkbox is a label showing the Meeting Chair 
person. This label can not be edited since there is no need to specify the meeting chair person here. 

If this is the first time you have used this dialog to create an IBM Lotus Sametime Meeting, the “Chair” 
label will be blank. If you have created an on-line meeting already the “Chair” label will display the meeting 
chairperson. A meeting chairperson can also be specified by entering a User Name in Meeting Options 
dialog (link to Meeting Options). 

Meeting Security 
You may elect to make your meeting more secure by setting the provided Security parameters. For 
example, you may want to require that all meeting participants enter a password before they can join the 
on-line meeting on the Sametime server. If so, enter the meeting password in the “Meeting Password” text 
box. 

Some Sametime environments may require a meeting password. If you are uncertain whether your does 
or not, check with your Sametime administrator. If your Sametime environment does not require a 
password, you may leave this blank or you may still require a password for your meeting by entering one 
here. 

If you do not want your meeting to be visible in the Sametime meeting center, check the “Do not list this 
meeting in the Sametime meeting center” checkbox. When you check this, all meeting participants will 
enter your meeting using the URL provided in the meeting invitation (link to Meeting Invitation). 

If you want only the people you specifically invite to the meeting to be able to attend your meeting, check 
the “Restrict the on-line meeting to invitees only” checkbox. If you check this, people will have to be 
logged into the Sametime meeting center and be one of your invitees before being permitted to attend 
your meeting. 
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Meeting File Attachments 
You may want to give your meeting attendees access to certain files for reference during the meeting. 
Use the “Browse…” button to find any files on your PC that would like to include as attachments to your 
meeting. These files will be uploaded to the IBM Sametime meeting server and made available to the 
attendees during the meeting. 

Clicking the “Browse…” button will open a standard Windows Browse dialog that will allow you to find the 
files you want to include. When you click the “Open” button on the Browse dialog, the selected file will be 
added to the “Added Files” list. 

If you decide that you want to remove a meeting attachment, select the file name from the “Added Files” 
list and then click the “Remove Selected” button. You will see the file name removed from the list and the 
attachment will no longer be included on the Sametime server. 

Meeting Options 
If you would like to give all of your invitees the chance to present information at your meeting, check the 
“All participants can present content in the meeting” checkbox. If you would like this meeting recorded for 
future reference, check the “Record this meeting” checkbox. 
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The Meeting Invitation 
Once you have made all of your selections in both the “Appointment” and “Sametime” tabs you send the 
meeting invitation by clicking the “Send” button in the Outlook Toolbar. 

When you open an IBM Sametime On-line meeting invitation you will see that information has been added 
to the body of the invitation email. 

This added information includes the URL that your invitees can use to attend the meeting. Clicking the 
URL will start your web browser and take you to the meeting page on the Sametime Meeting server. 

The body of the meeting invitation will also will include a meeting password if you specified one when 
creating the meeting. 

Updating an IBM Sametime On-line Meeting 
At some point before the meeting, you may decide to change certain meeting parameters. You can make 
changes to your IBM Sametime On-line meeting in the same way as you would for any meeting 
scheduled using Microsoft Outlook. One way to open a meeting for update is to go to your calendar grid 
and double click on the meeting. 

Open the meeting you want to change and you will see the Sametime tab with all the information just as 
you entered it when you created (or last updated) the meeting. Make any changes and then resend the 
meeting invitation. When you send the meeting invitation, your changes will automatically be made in the 
Sametime meeting server. 

If you changed the meeting password, the new password will also be added to the new meeting email 
invitation. 

Deleting an IBM Sametime On-line Meeting 
You may also delete your IBM Sametime On-line meeting just as you would for any meeting scheduled 
using Microsoft Outlook. One way to delete a meeting is to select the meeting in your calendar grid and 
press the “Delete” key on your keyboard. 

When you delete the meeting from Outlook, it will also be automatically deleted in the Sametime meeting 
server. 
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Logging into the Sametime Meeting Server 
The first time you create an IBM Sametime On-line meeting you will be asked to provide information that 
will used to log you into the Sametime server. You will only need to provide this information once. It will be 
stored and reused for subsequent meeting requests. 

The first time you send an invitation for an IBM Sametime On-line meeting you will see the log-in dialog. 

Enter your Sametime user name, Password and Sametime server name in the appropriate text boxes. 
Then click the OK button. If you need help in determining your IBM Sametime server name contact your 
Sametime administrator. 

If you should ever need to change your Sametime user name, Password or Sametime server name you 
may do so in the Meeting Options dialog (link to Meeting Options). 

Recurring Sametime On-line Meetings 
When you create recurring meeting in Microsoft Outlook that is also an IBM Sametime On-line Meeting, 
the Sametime Server URL in the body of the resulting meeting invitation will vary from that of a single 
meeting. The URL for a recurring meeting is designed to help the meeting participants easily locate any 
particular instance of the meeting on the Sametime Meeting server. 

If the recurring meeting is also restricted to only the meeting participants (link to description of “restricted” 
in meeting tab), the meeting URL will show all a list of all of the invitees meetings. 

16 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1 Release Notes 

If the meeting chair person has directed that the recurring meeting is not to be listed on the Sametime 
server (link to description of “list meeting” in meeting tab), then the meeting URL will take the invitee to the 
Sametime server page that allows a search for the meeting. 

If neither of these conditions apply, then 2 URLs will be presented, one will take the invitee to a list of all 
meetings in progress and the other to a list of all the meetings on the Sametime server. 

Sametime task menu in Microsoft Office Smart Tags 

(Sametime in Word/Excel/Power Point via Smart Tags) 

A chat can be initiated from within a Word, Excel, or Power Point document, with any name appearing in 
the document, provided that the name corresponds to a Sametime user. 

Type a name corresponding to a Sametime user in a document.  For Excel and Power Point, the name 
must also be a user that has been emailed from Outlook, or has had an email received from.  The name is 
underlined, and hovering over the name makes an icon appear. 
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Selecting the icon makes a drop-down appear, including a number of "Lotus Sametime" menu options.  If 
the chosen name is a registered Sametime user, the user's availability status will be reflected in the menu 
options, and various Sametime chat capabilities will be listed.  Select the desired option to launch a chat 
with that user. 

The tags take a moment to determine the person's availability status.  Tags will initially read "Checking 
user status...".  After a few moments, the user's status will be retrieved and displayed, or if the user has 
not been located as a Sametime user, the tag will now read "User not found".  A tag that stays in the 
"Checking user status..." or "User not found" states may also indicate a broken connection with the 
Sametime server. 

If a name is ambiguous, where several matches in the directory might correspond to the name as it has 
been typed, a selection arrow will appear to choose which Sametime user the tag should correspond to.  
Once a selection has been made as to which Sametime user the tag should correspond to, the tag 
remembers this selection for the remainder of the document's session.  If a mistake has been made, or 
the user wishes to choose a different Sametime user, an option appears that allows the tag to be cleared 
of its old choice by clicking "Choose different user".  The tag will now once again display the initial 
selection arrow so a different user may be chosen. 

The tag also allows operations through the Outlook Persona tag.  Simply choose "Additional Actions" 
under any tag triggered from any Contact or email address in Outlook to see Sametime chat options. 

18 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

Configuration options

You can configure how you want Sametime and Sametime Meetings to launch when you start Outlook.  

You can also synchronize your contacts by either coping contacts from Outlook to Sametime or Sametime

to Outlook.


Sametime Toolbar

The Sametime toolbar options page is found by going to the tools/options menu.

The Sametime options menu contains settings to control Sametime synchronization and launch settings.


Sametime Contact Settings 

The Sametime Contact Settings group box contains the options for synchronization of Sametime contacts 
with the Outlook contact list.  If synchronization is desired, there is a check box to enable the behavior.  
Select this check box and this will enable the radio buttons. 

z	 Automatically add new contacts -- Adds new contacts in outlook to the Sametime contact list 
automatically 

z	 Only add contacts with the following e-mail address suffix -- Adds only contacts with the specified 
filter.  Any users with that filter in their e-mail address will be added to the Sametime contacts list 
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Startup Options 

The Startup options group box contains options for behavior if Outlook starts but Sametime is not running. 

z	 Always launch Sametime when I start Outlook -- Allows you to always launch Sametime if it is not 
running 

z	 Prompt me to start Sametime -- Allows you to be prompted for the launch of Sametime if it is not 
running 

z	 Do Not start Sametime -- Configures the settings to run the toolbar without launching Sametime 

If the prompt has been selected and Sametime is not running, you are presented with the following dialog 

If you check “Do not ask me again” on this dialog and select “Yes”, the setting to always launch Sametime 
if it is not running will be set. 
If you check “Do not ask me again” on this dialog and select “No”, the setting to never launch Sametime if 
it is not running will be set. 
In either of these cases, you will not be prompted again unless you go back to the Options 
page/Sametime Toolbar and select “Prompt me to start Sametime” again. 
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Sametime Meeting 
The Sametime Meeting options page allows the user to change the Sametime Connection Settings and 
the behavior for synchronization between Outlook and Sametime Meetings. 

Sametime Connection Settings 

The Sametime Connection Settings group box displays the options for authentication with Sametime.  
Sametime requires you to authenticate in order to gain functionality that it provides.  You can 
input/change the username, password, and the Sametime server. 

Sametime Meeting Defaults 

Checking this box replicates outlook meetings in Sametime. 
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Synchronization 
Manual synchronization of contacts between Sametime and Outlook is possible by selecting one of the 
menu items from the Tools/ Synchronize Contacts menu.  You can either copy contacts from Outlook to 
Sametime or you can copy contacts from Sametime to Outlook. 

Synchronization of contacts from Outlook to Sametime 
The dialog to synchronize contacts from Outlook to Sametime allows you to copy contact information from 
Outlook to Sametime.  The dialog contains two tree controls.  The tree control on the left represents the 
folders and the contacts for Outlook.  The tree control on the right represents the Sametime group and 
contacts. The user selects a contact from the left tree and selects a group from the right tree.  Then user 
then can copy a contact from Outlook to Sametime by then selecting the move button that is located 
between the two tree controls. The user must then select OK to save the contacts to Sametime. 
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Synchronization of contacts from Sametime to Outlook 
The dialog to synchronize contacts from Sametime to Outlook allows you to copy contact information from 
Sametime to Outlook.  The dialog contains two tree controls.  The tree control on the left represents the 
Sametime groups and the contacts for Sametime.  The tree control on the right represents the Outlook 
and contacts. The user selects a contact from the left tree and selects a group from the right tree.  Then 
user then can copy a contact from Sametime to Outlook by then selecting the move button that is located 
between the two tree controls. The user must then select OK to save the contacts to Outlook. 

Sametime 

Limitations using Macintosh OS X 
Following are the known issues using the Macintosh OS X client in this beta release of Sametime 7.5.1: 

Note: Prior to installing and running the Sametime client, please be sure to have installed Java for Mac 
OS X 10.4 Release 5.  Please see: 

http://www.apple.com/support/downloads/javaformacosx104release5.html 

Sametime Client 

z Saving password is not supported 

z Location Awareness is not supported 

z Voice Chat will work only with the default Macintosh Audio Device 

z Video is not supported 
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Sametime Meetings 

z	 Screen Sharing is not supported on the Mac OS X client, however many of the User Interface 
elements do not reflect this, and appear to be available. 

z	 The Windows native Screen Sharing libraries are installed in a Macintosh client's user directory; 
these files can safely be deleted. 

z	 File transfer - When receiving a file from another participant in the Meeting, the default path in the 
save dialog is incorrectly pointing to a directory outside of the current user's home directory, thus 
the save will fail.  If the path is updated in the "Save" dialog, the filename itself will be lost. 

z	 Playback of a recorded meeting is currently broken on Macintosh OS X clients. 

z	 International - Users with Norwegian clients will see the Meetings client load in English. 

Sametime 

Spell checker overview 
The Sametime spell checker provides spell checking functionality for 12 languages.  The dictionaries are 
part of the server installation, and are found on CD 4, in a directory called "SpellCheckerDictionaries"; 
there are plugin and features for each dictionary. 

By default, the client comes with the US English dictionary installed.  Administrators can create a site that 
will allow users to install dictionaries as a feature, or a user can just copy the plugin folder for the 
dictionary to the plugin folder of their Sametime client.  The spell checker will default to English for 
languages it does not support. 

Supported languages in this release 

01 - com.ibm.langware.v5.dic.da_DK (Danish) 
02 - com.ibm.langware.v5.dic.fi_FI (Finish - Finland) 
03 - com.ibm.langware.v5.dic.fr_FR (French) 
04 - com.ibm.langware.v5.dic.el_GR (Greek) 
05 - com.ibm.langware.v5.dic.it_IT (Italian) 
06 - com.ibm.langware.v5.dic.nb_NO (Norwegian Bokmal) 
07 - com.ibm.langware.v5.dic.pl_PL (Polish) 
08 - com.ibm.langware.v5.dic.pt_PT (Portuguese - Portugal) 
09 - com.ibm.langware.v5.dic.pt_BR (Portuguese - Brazil) 
10 - com.ibm.langware.v5.dic.ru_RU (Russian) 
11 - com.ibm.langware.v5.dic.es_ES (Spanish) 
12 - com.ibm.langware.v5.dic.sv_SE (Swedish) 
13 - com.ibm.langware.v5.dic.de_CH (Swiss) 

Unsupported languages in this release 
1 - Hungarian 
2 - Turkish 
3 - Japanese 
4 - Korean 
5 - Simplified Chinese 
6 - Traditional Chinese 
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Installation, migration, upgrade, and configuration 
information 

Hardware requirements 

Sametime 

Hardware requirements for Sametime  7.5.1

Server hardware requirements


Sametime requires one server for Sametime installation that meets these requirements: 

Operating System - IBM eServer pSeries (AIX) 

z	 CPU -- Dual 475 MHz, or higher, IBM PowerPC processor recommended; Dual 375 MHz PowerPC 
processor minimum. 

z	 RAM -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 1 GB minimum. 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Operating system - i5/OS 

z	 IBM i5/OS, 5722SS1, Version 5 Release 3 or later. For more details, see "Installing and Managing 
Lotus Sametime 7.5 for i5/OS" (stinstall.pdf), available from the Lotus Sametime documentation page 
at http://www.ibm.com/developerworks/lotus/documentation/sametime. 

TM TM	 TM
z	 CPU -- IBM eServer iSeries , IBM eServer  i5, or IBM System i5  server models capable of running 

IBM i5/OS V5R3 

z	 RAM -- Minimum 1GB for each Sametime and Domino server 

z	 Disk space -- 1 GB required to run each Sametime server; 2 GB recommended. Minimum 4 disk 
drives (arms) required 

Operating system - Sun Solaris 

z	 CPU -- UltraSPARC III 1 GHz processor, or higher recommended; UltraSPARC III 550 MHz 
processor minimum 

z	 RAM -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 1 GB minimum. 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 
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Operating system - Microsoft Windows 

z	 CPU -- Intel Pentium III 800 MHz, or higher, recommended. 

z	 RAM -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 1 GB minimum 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Operating system - Linux x86 

z	 CPU -- Intel Pentium III 800 MHz, or higher, recommended. 

z	 RAM -- 2 GB recommended; 1 GB minimum. 

z	 Disk space -- 3 GB free disk space recommended to allow space for meetings; 2 GB minimum. 

z	 Disk swap space -- 1 GB minimum 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Client hardware requirements 

Client hardware requirements  - Windows 

z	 CPU - Pentium 3 800 MHz (or higher) 

z	 RAM - 512 MB random access memory or higher 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors. 

Client hardware requirements  - Linux 

z	 CPU - Pentium 3 800 MHz (or higher) 

z	 RAM - 512 MB random access memory or higher 

z	 Video requirements -- Video card installed.  Recommended video display color setting is 16-bit color.  
The setting must be higher than 256 colors 

Client hardware requirements  - Macintosh 

z	 CPU -- Macintosh OSX 10.4.6 (Tiger) with JVM 1.5, including patches for PowerPC and Intel J2SE 
5.0 Release 5. This is Java 1.5 and may have already been acquired through the the MacOS auto 
update. It is also available at 
http://www.apple.com/support/downloads/javaformacosx104release5.html. 

z	 RAM -- 512 MB random access memory or higher. 

z	 Disk space -- 1GB free disk space recommended to allow space for meetings; 500 MB minimum. 

z	 Disk swap space -- N/A 

z	 Video requirements -- Video card installed. Higher than 256 colors is required by Tiger 
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Client hardware requirements for Instant Messaging 

The client system requirements for operation with the Sametime 7.5.x server (and Multimedia Services) 

include:


z CPU - Pentium 3 800 MHz (or higher) 

z RAM - 512 MB random access memory or higher 

Client hardware requirements for Meetings 

z CPU - Pentium 3 800 MHz (or higher) 

z RAM - 512 MB random access memory or higher 

Sametime Mobile 

Hardware requirements for Sametime  7.5.1 Mobile

Mobile Client requirements


The following device types are supported for Sametime Mobile use: 

z Nokia ESeries 

z Microsoft Windows Mobile 5 Pocket PC and Smartphone 

z Microsoft Windows 2003 Second Edition Pocket PC 

z Research in Motion Blackberry 7100/8100/8700/8800 

z Sony Ericsson M600/P990 

Sametime 

Video Chat: Supported PC Cameras and WebCams

Following is the supported list of cameras for Sametime Video Chat:


z Logitech QuickCam Fusion Personal Web Camera 

z Creative Technology Live Ultra 

z Microsoft LifeCam VX-3000 Personal Camera 

z Logitech QuickCam Pro 5000 Personal Web Camera 

z Logitech QuickCam Communicate STX Personal Web Camera 

z Logitech QuickCam Personal Web Camera for Notebooks Pro 

z Logitech QuickCam Orbit MP 

z Creative Technology Live! Cam Notebook Pro Personal Web Camera 

z Creative Labs Live! Cam Video IM Pro 

z Microsoft LifeCam NX-6000 Personal Web Camera 

Note: These are the cameras that have been tested with Video Chat; most other cameras with supported 
webcam drivers should work.  Third-party drivers are not supported. 
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Software requirements 

Sametime 

IBM Lotus Sametime 7.5.1 Connect client software requirements 
Below are the software requirements and support statements for the Sametime 7.5.1 Connect client: 

Client operating systems - platforms supported 

Windows 

z	 Windows XP Professional Service Pack 2 

z	 Windows XP Professional 64-bit only for Web Conferencing 

z	 Windows 2000 

z	 Microsoft Vista - pre-release - http://www.microsoft.com/windowsvista/  Vista 1.0 is expected to 
ship on 1/30/07 

Linux 

z	 Red Hat Enterprise Linux 4.0 

z	 SuSE Linux Enterprise Desktop 10 

z	 Novell Linux Desktop 9 

Macintosh 

z	 Macintosh OSX 10.4.6 (Tiger) with JVM 1.5, including patches for PowerPC and Intel 

z	 J2SE 5.0 Release 5 
This is Java 1.5 and may have already been acquired through the the MacOS auto update. 
It is also available at 

http://www.apple.com/support/downloads/javaformacosx104release5.html. 

Client - Browsers 

z	 Mozilla 1.7.12 on Windows XP, Red Hat Enterprise Linux 4.0, Novell Linux Desktop 9 

z	 Firefox 1.5 on Windows XP, Red Hat Enterprise Linux 4.0, SUSE Linux Enterprise Desktop 10 

z	 Firefox 2.0 

z	 Internet Explorer 6.0, 7.0 on Windows XP Professional, Windows XP Professional 64-bit 

z	 Safari 2.0 on Macintosh OS X 10.4.x 

Client - Technology 

z	 Eclipse framework Expeditor (XPD) 6.1.1 

z	 XULRunner 1.8.0.1 

MS Office Integration 

z	 Office 2000 

z	 Office 2003 

z	 Office XP 

Sametime 
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IBM Lotus Sametime 7.5.1 Meetings requirements
 Below are the software requirements and support statements for Sametime 7.5.1 Meetings: 

Meetings 

Client - Browsers supported : 

z	 Mozilla 1.7.12 on Windows XP, RedHat Enterprise Linux 4.0, and Novell Linux Desktop 9.0 

z	 Firefox 1.5 on Windows XP, RedHat Enterprise Linux 4.0, SUSE Linux Enterprise Desktop 10 

z	 Firefox 2.0 

z	 IE 6.0, 7.0 on Windows XP Professional, Windows XP Professional 64-bit 

z	 Safari 2.0 on Macintosh OSX 10.4.x 

Java Development Kit /Java Runtime Environment  (JDK/JRE) supported 

Client JDK/JRE: 

z	 IBM or Sun JRE 1.4.2 and 1.5 for Web Conferencing - Internet Explorer 6.0 or 7.0 on Windows 
XP Professional 

z	 IBM or Sun JRE 1.4.2 and 1.5 for Web conferencing - RedHat Enterprise Linux 4.0 and Novell 
Linux Desktop 9.0 

Sametime 

IBM Lotus Sametime 7.5.1 Server software requirements 
Following are the software requirements and support statements for the Sametime 7.5.1 server: 

Server Operating System : 

z	 Windows 2000 server Service Pack 4 or later 

z	 Windows 2000 Advanced Server Service Pack 3 or later 

z	 Windows 2003 Standard and Windows 2003 Enterprise Editions Service Pack 1 or later 

z	 AIX 5.3 Technical Level 5 (for 7.5.1 release) 

z	 i5/OS Version 5, Release 3 and Version 5, Release 4 

z	 Solaris 9 and 10 

z	 Red Hat Enterprise Linux 4.0 Update 4 

z	 SUSE Linux Enterprise Server 10.0 

Notes 

z	 For more details on IBM i5/OS,  see "Installing and Managing Lotus Sametime 7.5.1 for i5/OS" 
(stinstall.pdf), available from the Lotus Sametime documentation page at 
http://www.ibm.com/developerworks/lotus/documentation/sametime. 

z	 On Windows, you must have full administration rights to install Sametime; if not, Sametime will 
not install properly.  In addition, please note that only Microsoft TCP/IP is supported for Windows. 

z	 On UNIX, you must install as root; if not, Sametime will not install properly. 

z	 The video display color setting on the Sametime server must be higher than 256 colors.  The 
recommended video display color setting is 16-bit color. 

z	 AIX, Solaris, and Linux do not require an X11 interface.  Administrators have the option to use 
X11 or the text-based console install version.  The console install will run from a telnet session or 
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equivalent. 

LDAP directories 

z Integrated Directory Services 5.2 & 6.0 

z Domino 6.5 

z Domino 7.0 

z MS Active Directory 2000, 2003 

z Sun ONE Directory 5 (iPlanet 5.1 & 5.2) 

Enterprise Meeting Server Infrastructure : 

z WebSphere V6.0.2.11 (fix pack 11) 

z DB2 UDB Workgroup Server Edition V8.2 

IBM Lotus Sametime Gateway Infrastructure : 

z WAS 6.1.0.3 + 6.1.0.3 ifix 

z DB2 UDB Workgroup Server Edition V8.2 

Supported Domino server version 

Sametime 7.5.1 must install on a Domino 7.x server.  Note that the Domino 7.x server release must be

installed prior to installing the Sametime server.


Sametime 

Sametime Client for Macintosh : Additional Java requirements

The following Java components are required to run the IBM Sametime Client 7.5.1 on the Macintosh OS

(Intel and PPC):


1.	 Java 2 Standard Edition (J2SE) 5.0 Release 5, available from

http://www.apple.com/support/downloads/javaformacosx104release5.html, or through the Tiger 

software updater.


Installation notes 

Sametime 

Silent Install configuration 
Two files are available that administrators can use to pre-configure the installation of the Sametime 7.5.1 
Connect Client for Windows in order to enable silent operation. The files can be found in the 
sametime-connect-win-7.5.1-silent-install.zip file which is included on the Sametime Connect 7.5.1 Client 
CD, and also in the Sametime Connect 7.5.1 Windows Client download.  For detailed instructions, see the 
Readme_silentinstall.html file which is also included in the zip file. 

The two files needed to enable silent installation are: 

z setup.bat 
Runs the installer in silent mode 
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z	 silentinstall.ini 
Provides configuration information for the installer. 

You can edit both of these files to tailor the installer to your specific requirements. 

setup.bat 
This batch file contains two commands: 

z	 vcredist_x86.exe: installs the Microsoft Visual C++ runtime components, which are needed for 
the optional Sametime Office integration features. If you do not need these features and do not want 
to install the Visual C++ runtime, you can remove or comment out this command line. 

z	 sametime-connect-win-7.5.1.exe: instructs the installer executable to run in silent mode. It 
contains several configuration parameters: 

install.log The name of the log file created by the installer

INSTALLDIR={path} Full path to the desired installation directory.

STSILENTINIFILE={name} Name of the silentinstall.ini file

STSILENTINSTALL=TRUE Must be TRUE for silent execution


silentinstall.ini 
This INI file contains configuration parameters for the Sametime client, which will be used to pre-populate 
the community-config.xml file with server connection information and other parameters required by 
the installer for silent execution. 

LAPAGREE=YES

STSERVERNAME=stservername.domain.com

STCOMMUNITYNAME=messaging

STSERVERPORT=1533

STSENDKEEPALIVE=true

STKEEPALIVETIME=60

STCONNECTIONTYPE75=direct

STPROXYHOST=

STPROXYPORT=

STRESOLVELOCALY75=

STPROXYUSERNAME=

STPROXYPASSWORD=

STCOUNTRYLANG=en

STOFFICEINTEGMEETINGTAB=

STOFFICEINTEGSMARTTAGS=

STOFFICEINTEGTOOLBAR=


Must be YES

Hostname of Sametime server

Community name

Sametime Server IP Port#

Flag for sending keepalive signal

Keepalive time

Connection type

Proxy host name (if used)

Proxy port# (if used)

Proxy resolves local flag (TRUE/FALSE)

Proxy user name (if used)

Proxy password (if used)

Language code (see detailed documentation)

Office integration: meeting tab (1=enabled)

Office integration: Smart Tags (1=enabled)

Office integration: Sametime toolbar (1=enabled)


NOTE:  All of the connection-related settings are used to set values in the community-config.xml file.  
For more information on these settings, see the Server Administration section of the IBM Lotus Sametime 
7.5.1 Information Center. 

Sametime 

Installing the Lotus Sametime 7.5.1 Software Development Kit

Starting with Lotus Sametime 7.5, all of the Sametime toolkits are available in the Lotus Sametime

Software Development Kit (SDK). The Lotus Sametime 7.5.1 SDK includes the following toolkits:
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z Sametime Connect Toolkit 
z Sametime Links Toolkit 
z Sametime Java Toolkit 
z Sametime Telephony Toolkit 
z Sametime Community Server Toolkit 
z Sametime Directory and Database Access Toolkit 
z Sametime Monitoring and Statistics Toolkit 
z Online Meeting Toolkit 
z Sametime Gateway Toolkit (new for 7.5.1) 

The Sametime toolkits for 7.5 and beyond are only available in the Sametime SDK, not individually. You 
can download the Lotus Sametime 7.5.1 SDK, and previous Sametime SDK and toolkit releases, by using 
the "Lotus Sametime 7.5.1 SDK" link on the Sametime server home page, or by going to the following IBM 
developerWorks site: 

http://www.ibm.com/developerworks/lotus/downloads/toolkits.html 

The Sametime SDK is packaged in a .zip archive file. To install the SDK, simply extract the contents of 
this file to any location on your local drive. After extracting the files, see the file readme.txt in the 
st751sdk directory for important information about the SDK.  To uninstall the SDK, simply delete the 
st751sdk directory. 

Note: The Sametime C++ Toolkit and COM Toolkit were not updated for the Sametime 7.5 or 7.5.1 
releases, and are not included in the Sametime SDK. The previous releases of these toolkits are still 
available on the developerWorks site, and should work with the Sametime 7.5.x releases, but there are no 
plans to further enhance these toolkits. 

Sametime 

Pre-installation steps for Linux Sametime Server  7.5.1 
Following are the steps to take before installing a Linux Sametime 7.5.1 server: 

1.	 Configure the default number of open file descriptors so Domino and Sametime can run without 
warnings. Add the following to the end of /etc/security/limit.conf: 
*	 hard nofile 65535 
*	 soft nofile 65535 

2.	 Disable the firewall.  For example, on RedHat, this can be achieved by running the following (it only 
needs to be run once; configuration is persistent):

chkconfig iptables off

service iptables stop


3.	 Make sure that the host file(/etc/hosts/) has an entry for the local hostname, where the server is 
installed and running. 

Sametime 

Linux Sametime Server 7.5.1 installation on VMWare 
Linux Sametime Server 7.5.1 is not supported or tested to run on RedHat or SUSE installations using 
virtual machine (VMWare) images.  Customers are advised to not install RedHat Enterprise Linux or 
SUSE supported versions under VMWare for installing Sametime Server 7.5.1. 

Sametime 
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Installing Sametime Conversion Services 
Sametime Conversion Services is a feature that takes files of various formats (slides, images, documents, 
etc.) and provides a bitmap rendering, so they can be shared in a meeting as slides.  Sametime 
Conversion Services has been enhanced to provide more faithful rendering of slides.  The same 
technology is used for all Sametime servers, regardless of the platform used for your Sametime server. 

For Sametime 7.5.1. there are two choices for running Sametime Conversion Services: 

z As a stand-alone Windows service on a separate Windows system (remote conversion server) 

If you plan to make significant use of Sametime Conversion Services, this option is preferred. It 
provides more faithful rendering of the slides for non-Windows Sametime servers. However, even for 
Windows Sametime servers, remote conversion has the advantage of offloading the work associated 
with file conversion from the Sametime server. 

z As an integrated function of your Sametime server (integrated conversion services) 

This capability is now available for all supported Sametime server platforms. It was previously 
available only for Windows Sametime servers. However, integrated conversion services on 
non-Windows Sametime servers will typically not produce slides with the same level of quality as a 
remote conversion server. 

In order to use a remote conversion server, you must install Sametime Conversion Services on a 
Windows system from the Sametime Components CD. The Sametime server must also be configured to 
connect to the Windows system. 

When you install Sametime 7.5.x on AIX, Linux, or Solaris, you are prompted to provide connection 

information for the system where you plan to run conversion services. For i5/OS, connection information

parameters are available on the command for adding Sametime to a Domino server (ADDLSTDOM). 


If you prefer, you can manually configure the conversion services information at a later time. 

Detailed information about setting up Sametime 7.5.1 Conversion Services are included in the 
"Configuring Meeting Services" section of the Lotus Sametime 7.5.1 Information Center. (In releases prior 
to Sametime 7.5, this information was provided in a separate guide.) 

Sametime 

Operating System Single Sign-On feature installation

The Operating System Single Sign-On feature allows Sametime Connect to retrieve the Windows

operating system password which can be used to log into Sametime. Once the feature is installed, the 

option to "Use my operating system password" is available in the Sametime login dialog. 


This feature is for Windows clients only. It is delivered on the Sametime Connect 7.5.1 CD and is also 

included in the Sametime Connect Web download for Windows. See the readme file included with CD or

download for more information. 


The installation of this feature requires the following: 

z Administrator rights 

z Installation of the SSO feature 

z Installation of a Windows service to retrieve the OS password 

z Reboot of the workstation when the installation is complete 

IMPORTANT Operating system SSO is an optional feature that poses additional security risks. The 
operating system SSO feature installs a Windows Service which allows Sametime client plugins to access 
the OS credentials. Do not use and distribute this optional feature unless you understand and accept 
these additional security risks. 

The OS Single Sign-On feature is packaged as an update site, including the necessary features and 
plugins directories, along with a site.xml file. The feature can either be added to an existing update site or 

33 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

installed from any accessible directory using the Tools menu: Tools > Plug-ins > Install Plug-ins.... 

Installing OS Single Sign-On 

1.	 Install the SSO feature. 

If the SSO feature is provisioned from an update site, the dialog will contain this Feature ID: 

com.ibm.rcp.security.sso.feature 

Otherwise, use the Tools menu to install the feature explicitly. 

2.	 When prompted, select "Restart Now" to restart Sametime Connect. 

3.	 Install the SSO Windows service by running ssoinstall.cmd. 

The ssoinstall.cmd file is located in the following subdirectory of the Sametime Connect installation 
directory (for example, C:\Program Files\IBM\Sametime Connect): 

\features\com.ibm.rcp.security.sso.feature_1.0.0.200701121759\install 

Either change your directory to this location to run ssoinstall.cmd, or double-click the file. 

4.	 Restart the machine. 

The option to "Use my operating system password" should now be displayed in the Sametime login 
dialog. On the Product Configuration page (Tools > Plug-Ins > Manage Plug-ins...), the feature Sametime 
Operating System Single Sign On Feature  should be displayed and enabled. You can verify the Windows 
service is installed correctly by looking at the Windows services console after restarting the machine. A 
service called IBM Workplace Client Technology Single Logon  should be listed and with a status of 
"Started". 

Troubleshooting 
If you had previously selected the login option to "Remember password" or "Automatically log in", then the 
login prompt may not be displayed so that you can select the new login option. To change the login 
option, complete these steps: 

1.	 Select File > Manage Communities... 

2.	 Expand the list of Communities in the left-hand pane 

3.	 Select a community in the left-hand pane to display the login options. 

4.	 Change the login option and restart Sametime Connect. 

Removing OS Single Sign-On 
Complete the following steps to remove the "Use my operating system password" checkbox from the login 
dialog and uninstall the Windows service that retrieves the OS password: 

1.	 Run ssoremove.cmd. 

The ssoremove.cmd file is located in the following subdirectory of the Sametime Connect installation 
directory (for example, C:\Program Files\IBM\Sametime Connect): 

\features\com.ibm.rcp.security.sso.feature_1.0.0.200701121759\install 

Either change your directory to this location to run ssoremove.cmd, or double-click the file. 

2.	 From Sametime Connect, select Tools > Plug-Ins > Manage Plug-ins... to display the Product 
Configuration page. Locate Sametime Operating System Single Sign On Feature  in the list of 
features, select it and click "Disable". You will be prompted to restart the Sametime client. The feature 
is disabled but it is still installed. 
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To completely uninstall the feature, return to the Product Configuration page after restarting the client. 
Be sure that the "Show Disabled Features" button is selected. Select Sametime Operating System 
Single Sign On Feature and click "Uninstall". Restart the Sametime client when prompted. 

3.	 Restart the machine. 

Sametime 

Installing additional Spell Checker dictionaries 
The Sametime Connect 7.5.1 Client CD and Web downloads contain plug-ins which can be used by 
Sametime Connect to check spelling for various languages. (The dictionary for United States English is 
included with the Sametime Connect installation.) 

To install one of the dictionaries, complete these steps: 

1.	 Browse the \OptionalComponents \SpellCheckerDictionaries \plugins directory on this CD and 
locate the folder that pertains to your preferred language (see table below). 

2.	 Copy the selected language folder and its contents to the plugins subdirectory of your Sametime 
Connect installation directory (for example, C:/Program Files/IBM/Sametime Connect/plugins). 

3.	 Once a dictionary is installed, you can select that language using the Spell Checking preferences. 

4.	 After selecting a different language dictionary, restart Sametime Connect. 

Dictionaries are available on the CD for each of the following languages: 

da_DK Danish 

de_CH German 

el_GR Greek 

en_AU English (Australia) 

en_UK English (United Kingdom) 

es_ES Spanish 

fi_FI Finnish 

fr_FR French 

it_IT Italian 

nb_NO Norwegian Bokmal 

pl_PL Polish 

pt_BR Portuguese (Brazil) 

pt_PT Portuguese (Portugal) 

ru_RU Russian 

sv_SE Swedish 

Sametime 
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Registry entry for Sametime installation directory 
The Sametime Connect 7.5.1 for Windows installer will create a key in the Windows registry that records 
the base installation directory.  This can be found in: 

HKEY_LOCAL_MACHINE\SOFTWARE\IBM\Sametime Connect\BasePath 

Upgrade notes 

Sametime 

Conversion Services upgrade required 
If you have been using Sametime Conversion Services with your current release of Sametime, there are 
several changes for Sametime 7.5.1 that you need to be aware of. Significant impacts to the upgrade 
process are highlighted below, but you should consult the Meeting Services section of the Sametime 7.5.1 
Information Center for detailed information.  

(Prior to Sametime 7.5, there was a separate Sametime Conversion Services Setup Guide. For Sametime 
7.5, this information was incorporated into the Sametime Administrator's Guide. For Sametime 7.5.1, see 
the Sametime Server Administration Help in the Sametime 7.5.1 Information Center.) 

z	 The requirements for the Windows system where you run the conversion services are the same 
for 7.5 and 7.5.1. They have changed since 7.0.  Make sure the system you are planning to use 
satisfies the requirements for 7.5.x. (This system is referred to as the Conversion Server.) 

z	 Previous versions of Sametime Conversion Services are not compatible with Sametime 7.5.1 
servers. You must uninstall the earlier version of Sametime Conversion Services from your 
remote conversion server, and install Sametime 7.5.1 Conversion Services for use with your 
Sametime 7.5.1 server. The new version can only be installed as a standalone Windows service. 

z	 Sametime 7.5.1 Conversion Services is not compatible with previous versions of Sametime. If you 
have multiple Sametime servers sharing the same Conversion Server, they can also share a 
single Sametime 7.5.1 Conversion Server once you have upgraded all of them to Sametime 
7.5.1. If you do not plan to upgrade all of the servers at the same time, you will need at least two 
Conversion Servers: one for the Sametime 7.5.1 servers and a separate one for the Sametime 
servers that have not yet been upgraded. 

z	 Sametime 7.5.x no longer stores the connection information for the Conversion Server in the 
meetingserver.ini file. The connection information is now stored in the stconvservices .properties 
file. For Sametime 7.5.1, this file is located in the stconversion subdirectory of the Sametime 
server data directory. (For Sametime 7.5, it was located in the Sametime server data directory.) If 
the IP address or port for the Conversion Server ever changes, you must update this file. 

z	 When you install Sametime on AIX, Linux, or Solaris, you will be prompted to provide connection 
information for the system where you plan to run conversion services. If you prefer, you can 
manually configure the conversion services information at a later time. 

z	 When you upgrade to Sametime 7.5.1 on i5/OS, existing Sametime servers are upgraded and the 
conversion server IP address and port number that were previously stored in the 
meetingserver.ini file are migrated to stconvservices .properties. After upgrading, you must 
update this file if the IP address or port for your Conversion Server are different from the previous 
release. 

Sametime 

Migrating privacy data after upgrading the server 

36 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

If you are migrating to Sametime 7.5.1 from Sametime 7.0, or an earlier release, and your users have 
stored privacy information ("Who can see me") from the earlier release, then you need to migrate this 
information by running a utility after upgrading.  Privacy information from the earlier release will not be 
used unless it is migrated. 

If you are upgrading to Sametime 7.5.1 from Sametime 7.5, and you already ran the 7.5 version of the 
utility, then there is no need to run it again on 7.5.1. 

For more information, see the Sametime Server Installation information for your server platform. 

Configuration notes 

Sametime 

Launching and configuring the Sametime Connect  7.5.1 client 
After you install the Lotus Sametime Connect 7.5.1 client, you can launch the client and complete the 
configuration as follows: 

1.	 If you wish to create a shortcut to the Sametime Connect client on your windows desktop, create one 
pointing to sametime.exe in the Sametime folder you installed the client to. 

2.	 Launch the client by running sametime.exe (Windows) or ./sametime (Linux) in the sametime 
directory that was created when you extracted the files. 

The first time you launch the client, you will need to enter the host name of your Sametime server. 
This could be a Sametime 7.5.x server or a pre-7.5 Sametime server. See the known limitations 
section for a list of the features that will not be available in the client if you connect to a pre-7.5 
Sametime server. 

The Sametime Connect 7.5.x client supports login to multiple Sametime communities from a single 
client instance. Your primary Sametime community is defined as the Sametime server you provide 
initially in the login window. Your primary server is where your contact list that holds users from 
multiple communities will actually be stored. In addition, the password to the primary community is the 
password you will use to "login" to the client each time you launch it. If you choose to define additional 
Sametime communities, you can select to have their password stored and to be logged in 
automatically to them, simply by logging in to your primary Sametime community. See instructions 
below for how to add additional Sametime communities. You can change your primary community by 
clicking the "Reset User" button on the Login dialog. 

Use the name of the server from which you downloaded the files, unless your administrator has 
instructed you to use a different server. 

3.	 After entering your primary community Sametime server in the host field, enter your user name and 
password for that community and click the Login button. 

4.	 After connecting to your Sametime server, your Contacts list will appear.  If you are connecting to a 
Sametime server that you have used before, you will see your existing Contacts list.  If you are 
connecting to this Sametime server for the first time, you will see a Contacts list with a group called 
"Work" containing your name. (Note: If you already have a Contacts list on this server, the Sametime 
Connect 7.5.x client will make a new copy of your Contacts list.  Any changes you make to your 
Contacts list using the Sametime Connect 7.5.x client will not be visible to older Sametime client 
releases). 

5.	 To add a new Contact or Group to your Contacts list, select File -> New -> Contact or Group. 

6.	 To add a new Community, select File -> New -> Community. Since we only support Sametime 
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communities in this release, click Next in the dialog that shows up. In the next dialog enter the

community information and select any options you would like.  Once the community is added, you will

see additional icons at the top left of the main client window. By clicking on these community icons

you can login/logout, change status and do other actions on each community.


The next time you launch the Sametime Connect 7.5.x client, the Login to Sametime window appears.  

Enter the password you specified in step 2 above, then click Login to connect to the server.  If you 

later decide to change either your logon password or any information you entered on the Login

Information screen (step 3 above), use the Reset User button on the Login to Sametime window.  

This will discard all of the information you have entered, and will start the configuration process again, 

as if you are launching the Sametime Connect 7.5.x client for the first time, allowing you to change

your primary community. Note that Reset User does not affect your Contacts list in this release.


Sametime 

Connecting to a Sametime server using a reverse proxy server 
As an Administrator, if you are connected to Sametime through a reverse proxy server, you cannot 
administer the server with the Administrator's Tool.  You must be inside the intranet of your company to 
administer the server. 

All other features of Sametime - meetings, chat, etc. - remain functional through the reverse proxy, except 
for the Administrator's Tool.  If you try to administer the server through a reverse proxy server connection, 
the Administration page will not display.  This is a security feature of Sametime. 

Sametime 

Configuring Sametime to work behind WebSEAL reverse proxy

The administrator's guide contains a "Using reverse proxy or portal servers with the Sametime server" 

that discusses using Sametime with reverse proxy servers.


If you are deploying Sametime behind a Tivoli WebSEAL reverse proxy server, there are some specific 

procedures and configurations you must employ to ensure the Sametime server can operate behind the 

WebSEAL reverse proxy server. These procedures and configurations are discussed below.


Note: The WebSEAL reverse proxy server must be listening on the default ports of 80 and 443 for the 

changes above to work.


To enable a Sametime server to operate behind a WebSEAL reverse proxy server:


1.	 You must configure the Sametime server to support HTTP tunneling on port 80. For instructions, refer 
to the "About HTTP tunneling" section in the "Configuring Sametime Connectivity" chapter of the 
Sametime 7.5 Administrator's Guide. 

2.	 You must open the stlinks.js file on the Sametime server and modify the following two lines to point to 
your WebSEAL reverse proxy server and WebSEAL junction (the WebSEAL junction is "st" in the 
example below): 

varII_RProxyName="https://ampc0.support.tivlab.austin.ibm.com"

varII_AffinityID="st"


var is TAM-env=true;

//racingConnTimeout-Timeout between racing connections in milliseconds. The value is sent to the

STLinks applet var racingConn Timeout=5000;


To configure the server to work with STLinks in a regular (not TAM) environment, leave the following lines
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in stlinks.js without any change:


var is TAM-env=false;

//racingConnTimeout-Timeout between racing connections in milliseconds. The value is sent to the

STLinks applet.


1.	 Enable reverse proxy support and specify the WebSEAL junction in the Sametime Administration Tool 
on the Sametime 7.5.x server. 

- Open the Sametime Administration Tool on the Sametime 7.5.x server. 

- Select Configuration-Connectivity. 

- In the "Reverse Proxy Support" section, select the "Enable Reverse Proxy Discovery on the client" 
setting to enable the reverse proxy support. 

- In the "Reverse Proxy Support" section, enter the WebSEAL junction name in the "Server Alias" 
field. In this example, "st" is the WebSEAL junction name. 

2.	 Create the Tivoli Access Manager WebSEAL junction as shown below: 

pdadmin> server task webseald-[servername] create -t tcp -h [sametime hostname] -p 80 -i -j -A -F [ 
path to LTPA key] -Z [LTPA key password]/junction 

You cannot use the -w parameter for this setup. Some requests generated by Sametime are not 
allowed through the junction if the -w exists. You must also ensure that the LTPA key used in the 
junction is the same LTPA key that the Sametime server uses in its Web SSO Configuration 
document 

After performing these configurations, you should be able to login to https://webseal/stjunction and be 
prompted by WebSEAL for authentication. Once authenticated, SSO between WebSEAL and Sametime 
should work and all requests for Sametime will route through WebSEAL. 

Sametime 

Sametime Administrator needs to be in LDAP for policies to work 
Existing Sametime customers that use LDAP may have the Sametime Administrator defined in the local 
Domino Directory. Until now, those customers did not need to have a Sametime Administrator defined in 
LDAP; this is now required for Policy Administration. 

Proper Configuration 
Add the Distinguished Name (DN) of an LDAP user to the Access Control List (ACL) of stconfig.nsf 
with the following access: Person/Manager - with all privileges  and all roles. 

Notes 

1.	 Make sure that you change the commas to slashes when entering the name into the ACL. 

2.	 In the third example below (Sametime Administrator), note that the canonical format changes to the 
hierarchical format.  Since the LDAP hierarchy matches Domino's hierarchy, the ACL will 
automatically normalize the name to the hierarchical format. 

For example, if you enter 'cn=Sametime Administrator/ou=Austin/O=IBM', the ACL will automatically 
show 'Sametime Administrator/Austin/IBM'.  When using Domino LDAP you will see this behavior, 
since the hierarchy of Domino LDAP matches the hierarchy system of standard Domino. 

Below are examples of what the DN looks like in LDAP, and what it should look like in the ACL: 
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LDAP Distinguished Name (DN) How name should appear in ACL 
1 cn=administrator,cn=users,dc=ibm,dc=com cn=administrator/cn=users/dc=ibm/dc=com 
2 uid=wpsadmin,cn=users,dc=ibm,dc=com uid=wpsadmin/cn=users/dc=ibm/dc=com 
3 cn=Sametime Administrator,ou=Austin,O=IBM Sametime Administrator/Austin/IBM 

With the above setup, the LDAP account specified in the ACL can now be used to administer the server

and, more importantly, administer and assign policies.


Sametime 

Sametime Connect and HTTPS connections on port  443 or 563 
This release note discusses issues pertaining to Sametime Connect client connectivity on port 443. These 
issues include: 

z	 Connecting to the Community Services on port 443 when the Domino HTTP server is configured to 
listen for SSL connections on port 443 

z	 Sametime 2.5 Connect client compatibility issue when connecting to a Sametime 7.5.x server on port 
443 or 563 

z	 Sametime 7.5.x Connect client compatibility issue when connecting to a Sametime 2.5 server on port 
443 or 563 

z	 Community Services multiplexer on Sametime 7.5.x server does not forward HTTPS connections on 
port 443 to the Domino HTTP server 

Connecting to the Community Services on port  443 when the Domino HTTP server is configured to

listen for SSL connections on port  443


Sametime installs on a Domino server. Web browser users connect to the Domino HTTP server when 
accessing the Sametime server. If the Domino HTTP server is configured to support SSL for Web browser 
connections, the Domino HTTP server is usually configured to listen for these HTTPS connections on port 
443 or port 563. 

Some Sametime Connect clients may operate in networks that require the clients to connect to the 
Internet or intranet through an HTTPS proxy. Many network environments that require users to connect 
through an HTTPS proxy only allow outbound connections to occur on port 443. If a Sametime Connect 
client operates in such an environment, the following configurations must exist on the Sametime Connect 
client and the Sametime server for the connection to be successful: 

In the Sametime Connect client Sametime Connectivity tab: 

z	 The "Community port" setting must specify port 443. 
z	 The "Use proxy" and "Use HTTPS proxy" settings must be selected. The IP address or DNS name of 

the HTTPS proxy server and port number used to connect to the HTTPS proxy server are also 
specified. 

z	 In the Sametime Administration Tool on the Sametime server, the Community Services Network - 
Address for HTTPS-tunneled client connections - Port number setting must specify port 443. 

With these configurations, the Sametime Connect client connects to the HTTPS proxy, and the proxy 
connects to the Sametime server on behalf of the Sametime Connect client. The connection from the 
proxy server to the Sametime server Community Services occurs on port 443. The Community Services 
on the Sametime server must be configured to listen for the HTTPS connections on port 443 to ensure the 
connection can succeed. 

Note The configurations above enable Sametime Connect to establish a connection to a Sametime server 
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through an HTTPS proxy server. The HTTPS connection method is used to establish the connection but

the data passing over this connection is not encrypted with SSL.  


If the Domino HTTP server is also configured to listen for HTTPS connections on port 443, a conflict

occurs because the Sametime Community Services are also configured to listen for HTTPS connections

on the same port number.


In this scenario, you must assign an additional IP address to the Sametime server to ensure that both 
Web browser users and Sametime Connect client users can connect to the Sametime server on port 443. 
This configuration requires the following steps: 

z	 Bind the DNS name for the Sametime server to the Sametime HTTP server. 
z	 Add a new IP address to the Sametime server machine. 
z	 Map the new IP address to a new DNS name for the Sametime Community Services. This 

configuration is performed on the DNS server. 
z	 Use the Sametime Administration Tool to add the new DNS name to the Community Services 

connectivity settings on the Sametime server. This configuration enables the Community Services to 
listen for HTTPS connections on the new DNS name. 

z	 Configure the Sametime Connect clients to connect to the new Community Services DNS name. 

Note The configuration described below can enable either a Sametime 2.5 (or higher) Connect client to

connect to a Sametime 7.5.x server on port 443 or 563.


Step-by-step instructions for these configurations are provided below. 

Step 1 - Bind the base DNS name for the Sametime server to the Sametime HTTP server . 

1.	 Open the Sametime Administration Tool and select Configuration-Connectivity-Networks and

Ports-Configure HTTP services on a Web page in its own window. The HTTP section of the Server

document in the Domino Directory opens and displays in a separate window on the computer.


2.	 Under the Basics heading in the "Host name" field, enter the base DNS name for the Sametime HTTP 
server (for example, www.sametime1.com). 

Under the Basics heading In the "Host name" field, also enter 127.0.0.1. This entry is required for the 
Sametime Administration Tool to operate in this configuration. Place a comma between the DNS 
name of the HTTP server and the 127.0.0.1 entry (e.g. www.sametime1.acme, 127.0.0.1) 

3.	 Click "Save & Close" at the top of the Server document. After the document closes, close the 

Server-Servers view of the Domino Directory.


Step 2 - Add a new IP address to the Sametime server machine .

To add a new IP address to the Sametime server, you can either install an additional Network

Interface Card (NIC) in the Sametime server machine or assign multiple IP addresses to a

single NIC.


To assign multiple IP addresses to a single NIC on a Windows machine: 

1.	 Open the Windows Control Panel. 

2.	 Click the Protocols tab. 

3.	 Select TCP/IP Protocols-Properties-Specify an IP Address. 

4.	 Click the Advanced tab. 

5.	 Use the Advanced IP Addressing screen to assign multiple IP addresses to a single NIC. 

Step 3 - Set up your DNS server to map the IP address to a DNS name for Sametime Community 

41 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

Services.

After you have added a new IP address to the Sametime server, set up your DNS server to map the new

IP address to a DNS name for the Sametime server Community Services.


For the Community Services, map the IP address to the DNS name "community-xxx.xxx.xxx"  (where 
xxx.xxx.xxx is the DNS name that was bound to the Sametime HTTP server in step 1 above). 

For example, you would map the new IP address to the DNS name "community-www.sametime1.com." 

Step 4 - Configure the HTTPS-tunneling settings in the Sametime Administration Tool

You must specify the new DNS name and port number for Community Services HTTPS connections in

the Sametime Administration Tool.


1.	 Open the Sametime Administration Tool and select Configuration-Connectivity-Networks and Ports. 

2.	 In the Community Services Network-Address for HTTPS-tunneled connections settings, specify the 

following:


Host name: community-xxx.xxx.xxx  (Where xxx.xxx.xxx is the DNS name that was bound to the 
Sametime HTTP server. For example, community-www.sametime1.com.) 

Port number: 443 

With this configuration, the Sametime Community Services multiplexer will listen for HTTPS-tunneled 

connections on host name community-www.sametime1.com on port 443.


Step 5 - Configure the Sametime Connect clients to connect to the new DNS name of the Community

Services

To connect to a Sametime server configured to listen for HTTPS connections on the host name and port

specified above, the Sametime Connect client must have the following settings in the Sametime

Connectivity tab:


z	 The "Host" setting must specify community-www.sametime1.com. 

Note If a Sametime 2.5 Connect client connects to a Sametime 7.5.x server using HTTPS on port 443 
or 563, it is only necessary to enter the server name (www.sametime1.com) in the "Host" setting of 
the Sametime 2.5 Connect client. For example, enter "www.sametime1.com" instead of 
"community-www.sametime1.com" in the "Host" field. For more information, see "Sametime 2.5 
Connect client compatibility issue when connecting to a Sametime 7.5.x server on port 443 or 563" 
below. 

z	 The "Community port" setting must specify 443. 

z	 "Use proxy" and "Use HTTPS proxy" must be selected. Enter the host name and port on which the 
Sametime Connect client connects to the HTTPS proxy. 

Sametime 2.5 Connect client compatibility issue when connecting to a Sametime  7.5.x server on port 
443 or 563 
The Sametime 2.5 Connect client is designed to use HTTPS tunneling on ports 443 or 563 to connect to a 
server that uses multiple IP addresses. 

When a Sametime 2.5 server is configured to listen for HTTPS-tunneled client connections on port 443 or 
563, the server listens for Community Services connections on the server name 
"Community-servername." For example, if your Sametime 2.5 server is named 
sametimeserver.acme.com, the server listens for HTTPS-tunneled Community Services connections on 
ports 443 or 563 on the server name "Community-sametimeserver.acme.com." The Sametime 2.5 server 
is hard-coded to prepend the string "Community-" to its server name when listening for Community 
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Services connections on ports 443 or 563. This design in the Sametime 2.5 server accomodates the

multiple IP address issues discussed in "Connecting to the Community Services on port 443 when the 

Domino HTTP server is configured to listen for SSL connections on port 443" above.


The Sametime 2.5 Connect client is also hard-coded to prepend the string "Community-" to its Host

setting when its "Community port" setting specifies port 443 or 563. For example, assume the following

settings exist in the Sametime Connectivity tab of a Sametime 2.5 Connect client:


z	 Host - "sametimeserver1.acme.com" 
z	 Community port - Either port 443 or port 563 is specified. 

With this configuration, the Sametime 2.5 Connect client attempts the connection to the server

name "Community-sametimeserver1.acme.com" even though the string 

"sametimeserver1.acme.com" is entered in its Host setting.


Because the Sametime 2.5 Connect client automatically prepends the string "Community-" to its host 
name, it is not necessary to enter the string "Community-servername" in the Sametime 2.5 Connect client 
when this client connects to a Sametime 7.5.x server that is configured to listen for HTTPS connections 
on multiple IP addresses. 

Note also that when a Sametime 7.5.x server listens for HTTPS-tunneled connections from Sametime 2.5 
Connect clients, the additional DNS name assigned to the Community Services on the Sametime 7.5.x 
server must begin with the "Community-" string, as described in "Connecting to the Community Services 
on port 443 when the Domino HTTP server is configured to listen for SSL connections on port 443" 
above. If the Sametime 7.5.x Community Services DNS name does not begin with the "Community-" 
string, the Sametime 2.5 Connect client cannot connect to the Sametime 7.5.x server.   

Sametime 7.5.x Connect client compatibility issue when connecting to a Sametime  2.5 server on port

443 or 563

If a Sametime 7.5.x Connect client connects via HTTPS-tunneling to a Sametime 2.5 server on port 443 

or 563, the Sametime 7.5.x Connect client does not prepend the "Community-" string to its host name

when making the connection to the Sametime 2.5 server.


The Sametime 2.5 server is hard-coded to prepend the string "Community-" to its server name when 
listening for HTTPS connections on port 443 or 563. To ensure the Sametime 7.5.x Connect client can 
connect to the Sametime 2.5 Community Services on port 443 or 563, the string "Community-" must be 
manually added to the Host name in the Sametime Connectivity tab in the Sametime 7.5.x Connect client. 

Manually adding the "Community-" string to the Host name in the Sametime 7.5.x Connect client ensures 
that the client attempts the connections on the name on which the Sametime 2.5 server listens for the 
connections. 

For example, to ensure a Sametime 7.5.x Connect client can connect on port 443 or 563 to the Sametime 
2.5 server named "sametimeserver1.acme.com," the following settings must exist in the Sametime

Connectivity tab of the Sametime 7.5.x Connect client:


z	 Host - "Community-sametimeserver1.acme.com." 
z	 Community port - Either port 443 or port 563 is specified. (Specify the port on which the 

Sametime 2.5 server listens for HTTPS-tunneled connections). 

Community Services multiplexer on Sametime  7.5.x server does not forward HTTPS connections on port 
443 to the Domino HTTP server 
A Sametime 7.5.x server can simulaneously listen for HTTP connections to multiple services on port 80 
when the Sametime server machine includes a single IP address. For example: 

z	 A Web browser can connect to the Domino HTTP server on a Sametime server on port 80. 
z	 A Sametime Connect client can make an HTTP-tunneled connection to the Sametime 
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Community Services on port 80. 
z	 A Sametime Meeting Room client can make HTTP-tunneled connections to both the 

Sametime Community Services and Meeting Services on port 80. 

All of these connections can occur to the same DNS name using port 80. On a Sametime 7.5.x server, it 
is not necessary to assign separate IP addresses to the HTTP Services, Community Services, and 
Meeting Services to enable connections to all services to occur using a single DNS name on port 80. The 
design of the Community Services multiplexer on a Sametime 7.5.x server makes this capability possible. 
The Community Services multiplexer can listen for HTTP connections from Web browsers, Sametime 
Connect clients, and Sametime Meeting Room clients on port 80. The Community Services multiplexer 
examines these connections and then forwards the connections to the appropriate service. For example, 
the Community Services multiplexer forwards the Web browser connections to the Domino HTTP Server, 
the Community Services connections to the Community Services, and the Meeting Services connections 
to the Meeting Services. 

Note that the Community Services multiplexer on a Sametime 7.5.x server cannot listen for connections 
on port 443 or 563 and then forward these connections to the Domino HTTP server. The Community 
Services multiplexer can forward HTTP connections on port 80 to the Domino HTTP server, but not 
connections on port 443 or 563. For this reason, a Sametime 7.5.x server must be assigned multiple IP 
addresses when both the Domino HTTP server and the Sametime Community Services on the Sametime 
server must listen for connections on port 443 or 563. The Community Services multiplexer on a 
Sametime 7.5.x server also cannot listen for HTTPS connections to the Sametime Meeting Services or 
Community Services on ports 443 or 563 and forward these connections to the Community Services and 
Meeting Services. HTTPS-tunneling to the Sametime Meeting Services is not supported. Sametime 
Meeting Room clients cannot connect to the Sametime Meeting Services through an HTTPS proxy server. 

Sametime 

Windows DEP process causes launch error

If Windows server administrators are running the Data Execution Prevention (DEP) process on their

Windows server, the server will view the Sametime launch task StLaunch as a potentially malicious

thread, and halt the process. The error message received is:


To Help protect your computer, Windows has closed this program:Name: 
StLaunchPublisher: 

Workaround

Turn off the DEP process on Windows servers before launching the StLaunch task.


Sametime 

Adjusting the logging level in sametime .properties 
For the Sametime client, the properties relevant to logging into sametime.properties are described 
below. The sametime.properties file is found in the installation root.  By default the .level value is 
set to INFO. 

## Logging properties

.level=INFO

logger.filename=sametime.log

logger.includeClassInfo=true

logger.toConsole=true

logger.level=ALL

logger.limit=20000000

logger.count=4

redirectSystemOutput=false
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.level 
The default logging level for the application.  This level is applied to the root logger, and the level that 
should be changed to trigger more verbose logging. 

The options from most verbose to least verbose are as follows: 

FINEST 
FINER 
FINE - shows fine messages, which produces much useful debug information 
INFO - default level 
WARNING 
SEVERE 

If experiencing a bug, set .level to FINE, reproduce the problem and examine the sametime.log.0 
file located in the user workspace, typically "C:\Documents and 
Settings\<username>\Application Data\Sametime" on a Windows system. 

Sametime, Sametime Gateway, Sametime Mobile 

Allow only one chat client connection per IP address 
Two new flags have been added to the sametime.ini file: 

VP_ONLY_SINGLE_LOGIN_ALLOWED=1 --> If this flag is set in the 'Config' section, the "single client 
log-in" mode is activated 

VPS_EXCLUDED_LOGIN_TYPES --> Comma-separated list of client types. These types will not be 
considered as "log-ins" when the server checks whether to accept or disconnect clients 

Single client login 
"Single log-in type" mode means that only one login per user is allowed. When a client tries to log in to the 
server, a check is performed to determine whether there are already any log-ins of the same user, and 
disconnect them. When the previous log-ins have a log-in type from the excluded list, they will not be 
disconnected.  When the new log-in type is from the excluded list, the old log-ins will not be disconnected.  
Generally, log-in types in the "excluded" list are "transparent" for disconnection purposes. 

Example: 

[Config] 
VPS_EXCLUDED_LOGIN_TYPES=1002,1304 
VP_ONLY_SINGLE_LOGIN_ALLOWED=1 

"Single client log-in" mode will be activated, but the log-ins originated from clients with type 0x1002 or 
0x1304 will not count for the disconnection.  They will not be disconnected and, when they are 
connecting, they will not disconnect any other clients. 

Client Types: 

1002 - C++ client 
1003 - Java client 
100A - ST Links 
1100 - Notes Hannover Client 
1304 - UIM client 

Sametime 
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Case-sensitivity for the client 
By default, the client is case-sensitive, but can be made case-insensitive by updating the 
plugin_customization.ini file with the value below, and restarting the client: 

com.ibm.collaboration.realtime.people/isCaseInsensitive=false 

The plugin_customization.ini file is located directly inside the installation directory. 

Sametime 

Case insensitive ID compare

The Sametime server, by default, is case-sensitive; now it can be configured to be case-insensitive. 

Case-insensitive ID comparison allows IM awareness in Domino Web Access and Portal.  This 

configuration is made by changing the sametime.ini file as follows:


In the [Config] section add AWARENESS_CASE_SENSITIVE=0

z   By default the value of this configuration flag is 1, and the Sametime server is case-sensitive, 

z   When you set this flag to 0, the Sametime server is case-insensitive 

z   You must shutdown and restart the Sametime server for the change to take effect. 

It is recommended that the Sametime Client be configured to support this feature. 

Sametime, Sametime Gateway, Sametime Mobile 

Collecting Resolve statistics

To configure the server to collect Resolve statistics please follow these steps:


1. Make sure the StStatistics service is installed and running. 

2. Add the following flag to the sametime.ini file under the [Debug] section: 
VPSTATISTICS_RESOLVE=1 

3. Restart StStatistics and StResolve. 

The statistics data will be written to a file called STStatistics_<date>_<time>.txt under the Trace 
folder. 

Please refer to the "Resolve statistics" item of the 'New features in IBM Lotus Sametime 7.5.1' document 

in these release notes for additional details about statistics data collected for Resolve operations.


Sametime, Sametime Gateway, Sametime Mobile 

Configurable preferred log-in list

If a user is connected with several different clients, and another user is initializing an IM session, it is

unclear which client should receive the IM session.


The default implementation is contingent on the hard-coded list of client types; each type has its 

predefined weight.  In the server, all the logins of the same user are ordered according to the login type

weight. When there is an incoming IM session, the first login (having minimal weight) is taken from the

list; and the session is sent to it.


Default order: 0x1304, 0x1100, 0x1003, 0x1002, 0x1000, 0x1001 

The new ability presented in Sametime 7.5.1, make it easy to change the default login types order. Use

the VPS_PREFERRED_LOGIN_TYPES flag in the sametime.ini file to provide an additional list of login

types. The login types from this list will always be "more important" than the default login types.  The list
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should be comma-separated, and should contain client types in hexadecimal format, but without the 
leading "0x". 

Example: 

In sametime.ini: 

[Config] 

VPS_PREFERRED_LOGIN_TYPES=1002,1304 

Suppose that user A is logged in with two clients: 1304 (UIM blue) and 1002 (6.5 C++). User B connects 
to user A and starts a chat. According to the default list, the UIM client should pop-up the chat dialog, but 
because of the VPS_PREFERRED_LOGIN_TYPES list supplied in the sametime.ini, the C++ client will get 
the chat. 

Please also see the related technote # 1253176. 

Client Types: 

1000 - C++ toolkit 
1001 - Java toolkit 
1002 - C++ client 
1003 - Java client 
100A - ST Links 
1100 - Notes 8 Standard Client 
1304 - UIM client 

Sametime 

Conversion Services on Windows Sametime servers

Sametime Conversion Services is a feature that takes files of various formats (slides, images, documents, 

etc.) and provides a bitmap rendering, so they can be shared in a meeting as slides.  


In Sametime 7.5, Sametime Conversion Services was installed by default as a Domino servlet. This 

required special configuration steps if the Sametime server was configured for SSL. 


With Sametime 7.5.1, the option for running Sametime Conversion Services as a Domino servlet is no

longer supported. By default, the conversion services run as an integrated function of the Sametime

server. However, you still have the option to run conversion services on a separate Windows system in

order to offload the workload associated with file conversion from the Sametime server.  


For more information see "Configuring the Meeting Services" in the Sametime Server Administration

section of the Sametime 7.5.1 Information Center.


Sametime, Sametime Gateway, Sametime Mobile 

Disabling partial search for users or public groups 
In order to disable the partial search option, please add the following flag to the sametime.ini file, under 
the [Debug] section: 

ST_RESOLVE_NAMELOOKUP_NONPARTIAL=1 

and restart the StResolve service. 

Please refer to the "Partial search for users or public groups" item of the 'New features in IBM Lotus 
Sametime 7.5.1' document in these release notes for additional details about partial search. 
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Sametime, Sametime Gateway, Sametime Mobile 

Force users to connect through home cluster 
Sometimes, it is essential that users connect to their home server, for example, when using Facetime.  In 
this case, to prevent the ability to connect to remote servers, forwarded log-ins should be rejected during 
the log-in process.  This means that users should connect only to their home server. 

This release note relates to both servers and clusters. Every user will be available to connect directly only 
to their home server/cluster. The log-in requests, which are forwarded from distributed (remote) 
servers/clusters will be rejected. 

In order to force users to connect to a given server/cluster through a proxy or a list, this feature, 
configurable through sametime.ini, is available. 

How to configure : 

In the sametime.ini file, in the [Connectivity] section, the VPMX_TRUSTED_CLIENT_IPS setting 
should be set to a comma-separated list of trusted IP addresses.  These addresses should be the proxy 
addresses. 

An empty list (default) means the feature is turned off, and clients from all IP addresses can connect.  
Note that users should not be allowed to work directly on the proxy machine, or the limit is bypassed. 

Sametime 

Multiple Community considerations 
The Sametime 7.5.x Connect client supports the ability to define multiple Sametime communities in an 
interface, and be logged into one or more of those communities at the same time.  There are some 
important points to consider if you need to define more than one community or switch from one 
community to another: 

z	 If you have multiple communities in which some are 7.5.x communities and some are pre-7.5 
communities, you should define your primary community (the main community defined first when 
the client is first run) as your most used 7.5.x community. 

z	 Some features in 7.5.x work only with your primary community and require policies to be enabled 
for them, for example telephony.  You will not be able to participate in telephony calls with users 
of a community that is not defined as your primary community. 

z	 Selective 'Do Not Disturb' requires a 7.5.x server, and will only work with users from your primary 
community. 

Sametime 

New UNIX config values not always propagated by single restart 
At a high level, configuration values on a Sametime server are provided to system components by a 
configuration servlet.  The values provided by this servlet are stored in a cache to improve performance. 
When system components retrieve values, these values come from the cache. 

If configuration changes are made directly to a data source, such as STConfig.nsf or sametime.ini, the 
server must be restarted.  On Windows, as the server comes up, the config cache is refreshed from the 
config servlet before system components can retrieve values from the cache. 

On UNIX, however, the order of component startup is more random than on Windows.  As a result, it's 
possible that system components will retrieve configuration values from the cache before it gets 
refreshed.  As a result, the refresh of the cache occurs after values have already been retrieved.  If this 
happens, a second restart of the server will guarantee that system components retrieve the freshest 
configuration values. 
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There are a couple of other methods for changing configuration values that should assure retrieval of the 
latest values: 

1. Make the configuration changes.

2 Stop the server. 

3. Delete the file 'SametimeCommunity2.xml' from the data directory. 

4. Restart the server. 

Or method: 

1. Make the configuration changes.

2. In the Domino console, restart the HTTP server with the command 'tell http restart'. 

3. Wait a few moments for Domino to respond that the HTTP server has restarted. 

4. Restart the entire server.

Either of these methods should cause sytem components to retrieve the latest configuration values. 

Sametime 

Notifying a user when a messaging partner closes the chat window 
When two people are chatting in an instant messaging window and one person closes the window, the 
second person's window remains open.  You can configure a message to inform the second person when 
their messaging partner is no longer online: 

1. Navigate to the lotus/domino folder (the same folder where the sametime.ini file is stored). 

2. Create a file called stGateway.ini. 

3. In the new file, insert the following key with a message similar to the example shown below: 

VP_IM_FAILED_MESSAGE=Your Messaging partner is no longer online. 

4. Save the new file. 

Sametime 

Sametime Connect client file transfer overview 
The Sametime Connect client can transfer files by either one of two methods: via the server (RTC), or via 
peer to peer (P2P). The method is chosen programmatically at runtime and depends on server settings, 
as well as client settings. 

Server file transfer  (RTC) 
When this method is used, the Sametime Connect client will call upon the Real-Time Collaboration (RTC) 
API to transfer the file.  The RTC layer then communicates directly with the Sametime server, and passes 
the file through the server to the receiving user.  RTC file transfers honor the existing Sametime user 
policies for allow/disallow file transfer, maximum size of file allowed, and file types disallowed from 
transfer. 

Peer-to-peer file transfer (P2P) 
When this method is used, the Sametime Connect client will attempt to connect directly to the chat 
partner's machine, and transfer the file if a successful connection is established.  P2P file transfers 
bypass all Sametime file transfer user policy checks, i.e. file sizes and file types.  In order to be able to 
use this transfer method, the user's sametime.properties file must contain the p2p flag ( 
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filetransferP2pAllow) set to 'True'.  This file can be found in the Sametime Connect client install 
directory. 

Once Sametime CF1 or later is installed however,  the Sametime administrator can make use of a new 
server policy to control P2P file transfers.  The sametime.properties p2p flag will no longer be supported. 

Virus Scanning 
Though not directly related to 'how' a file is transferred, the existence of the virus scanner in the Sametime 
server helps determine 'which' method is used for transfer. The Sametime server has hooks to allow for 
the operation of a third-party virus scanning tool.  If the server is configured to virus scan, then the method 
used for transfer must be the server.  P2P file transfers do not get scanned for viruses. 

RTC or P2P? 
The first thing that needs to be determined is whether or not the user is allowed to transfer files.  This is 
done by first looking at the Sametime server setting for "Community Services - Allow users to transfer 
files".  This is a global setting that affects all users in that Sametime community.  This setting is then 
combined with the Sametime User Policy setting.  The outcome is the final Sametime Connect policy for 
file transfer. 

The following table shows the possible outcomes in this scenario. 

Sametime User Policy Sametime User Policy 
allows file transfers does NOT allow file 

transfers. 

Sametime server allows Sametime Connect client Sametime Connect client 
users to transfer files allows file transfers. does NOT allow file 

transfers. 

Sametime server does Sametime Connect client Sametime Connect client 
NOT allow users to does NOT allow file does NOT allow file 

transfer files transfers. transfers. 

The Sametime Connect client does NOT allow file transfers

If the Sametime Connect client does not allow file transfers and both users' (sender and receiver) 

sametime.properties file contains the P2P flag (see above), and both users have P2P capability, 

then the file transfer will occur via P2P; any Sametime Connect 7.5.x client has P2P capabilities.


The Sametime Connect client allows file transfers

Once you know you have permission from the server to transfer files, the next step is to check 

whether or not you have a working virus scanner on the server.


Virus scanning is enabled on the server

With virus scanning enabled on the server, the file transfer will occur via the server (RTC) 

with a message on the chat window indicating this.


Virus scanning is not enabled on the server

If virus scanning is not enabled on the server, the file transfer will occur via P2P, if the

users (sender and receiver) both have the P2P flag set and have P2P capability.  A 

message is displayed in the chat window indicating that the file will not be scanned for

viruses.


In the event that either user does not have P2P flag enabled or capability, the file will be

transferred via RTC, also with a message in the chat window indicating that the file will

not be scanned for viruses.
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Sametime Connect 7.5.x client and pre-Sametime Connect 7.5.x client

File transfer between the 7.5.x client and pre-7.5 clients will always go through the server.  Pre-7.5 clients

are not P2P capable. As such, when chatting from a 7.5.x client to a pre-7.5 client, if file transfer is not

allowed in the user Policy, then the file transfer icon will be disabled for the pre-7.5 client user.  This is the

result of a "Capabilities" check.


Which transfer method is my client using ?

Debug sametime client logs are needed to determine this:


1.	 Open sametime.properties 
2.	 Set '.level' to "FINE" (.level=FINE).  NOTE: do not confuse ‘.level’ with ‘logger.level’. 
3.	 Use your client for file transfer 
4.	 Go to the Sametime user folder (this is not the install folder; the Sametime user folder can found 

within the user’s C:\Documents and Settings folder) 
5.	 Locate file name sametime.log.0 

Server (RTC) file transfer logging will look like this: 

[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: File Transfer enabled in Policy
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus scanning is available for this file transfer
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus Scanning is enabled.  Using RTC file
Transfer. 
[com.ibm.collaboration.realtime.filetransfer.rtc.FileTransferServiceRtc 
.fileTransferStarted] ::FINE:: RTC File Transfer Started... 
[com.ibm.collaboration.realtime.filetransfer.rtc.FileTransferServiceRtc 
.fileTransferCompleted] ::INFO:: RTC File Transfer Completed 

P2P file transfer logging will look like this: 

[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: File Transfer disabled in Policy.  Using P2P. 
[com.ibm.collaboration.realtime.filetransfer.FileTransferServiceFactory. 
getService] ::FINE:: Virus scanning is not available
[com.ibm.collaboration.realtime.filetransfer.
.startTransfer] ::FINE:: Transfer started... 

p2p.FileSender 

[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender
.closeFileInputStream] ::FINE:: Closing file input stream... 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileTransferServer.addF 
ileSender] ::FINE:: added id1155131608343 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileTransferServer.star 
tServer] ::FINE:: Starting filetransfer server on port 5656 
[com.ibm.collaboration.realtime.rtcadapter.meeting.ChatAdapter.messageRe 
ceived] ::FINE:: messageReceived [meeting CONV$4DEA2B75C606C469] msg 
type: text 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender.onTransferAc 
cepted] ::FINE:: [Transfer accepted] notice received 
[com.ibm.collaboration.realtime.filetransfer.p2p.FileSender.onTransferAc 
cepted] ::FINE:: Transfer accepted by receiver. Testing connectivity... 

Sametime 

Sametime does not provide a virus scanner 
Sametime 7.5.x does not provide a virus scanner. However, Sametime 7.5.x can be configured to call a 
third-party virus scanning program before transferring a file. 

Do not choose "Always" as the value for "Virus scan files before transferring" in Sametime Administration 
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unless you have acquired and deployed a virus scanning program. 

Sametime, Sametime Gateway, Sametime Mobile 

Sametime Policy for Anonymous user 
If Anonymous user access is allowed by a Sametime administrator, a specific policy needs to be provided 
for anonymous users.  A new "Anonymous" policy set is provided in the stpolicy.ntf template; it 
includes the same attribute set as any other specific policy. 

The Sametime server installation process establishes stpolicy.nsf. As a result, this data storage 
includes two built-in policy documents: the Default policy set and the Anonymous user policy set. 

Using Policy API, the Admin UI Policies page shows the policy rules and assignments.  The Administrator 
can create new user policy sets and assign users and groups to them.  The Administrator is unable to 
delete the necessary policy sets (Default and Anonymous) and to assign users/groups to them as well. 

If an Administrator does not intend to apply a specific policy to an anonymous user, they can set all of the 
Anonymous policy attribute values as inherited from the Default policy set. Then, an Anonymous user will 
get the default policies applied. 

Even if administrator marks some attribute in the Default policy set as "Override all policies", the same 
attribute in the Anonymous policy set gets its own policy value, since the Anonymous policy is designed to 
be stricter than any other policy as well as that the Default policy. 

Sametime, Sametime Gateway, Sametime Mobile 

STPolicy exhaustive search through Domino Directory 
The NOTES_NAME_LOOKUP_EXHAUSTIVE flag in the [Policy] section of the sametime.ini file indicates 
which kind of Directory search is used. If NOTES_NAME_LOOKUP_EXHAUSTIVE=1 is set, STPolicy 
Notes BlackBox performs an exhaustive memberOf search through all the NABs, both local and those 
referred by da.nsf. 

Otherwise, when either NOTES_NAME_LOOKUP_EXHAUSTIVE=0, or is not provided, only the local 
names.nsf is searched. 

Sametime 

User Consent framework 
The Sametime server, by default, allows external users to watch internal users; now it can be configured 
so that, by default, all external users are not allowed to watch internal users.  This configuration is made 
by changing the sametime.ini file as follows: 

In the [Config] section add AWARENESS_EXTERNAL_NEED_PERMISSION=1 

z	 By default the value of this configuration flag is 0, and the Sametime server  allows external users 
to watch internal users 

z	 When you set this flag to 1, by default,  all external users are not allowed to watch internal users 

z	 You must shutdown and restart the Sametime server for the change to take effect. 

In the Sametime UIM client, when an external user subscribes to watch an internal user, the internal 
Sametime UIM client user will be notified by the server, and can decide whether or not to allow the 
external user to watch their status, and be able to start a chat. 

52 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

Sametime 

Video Chat: Automatically adjusting bit rate 
RTCP is used for finding out the current network conditions; it is the feedback mechanism for the 
Sametime Video Engine. Based on the current network conditions and packet loss, the send bit rate is 
adjusted by the video engine.  The bit-rate increases if more network bandwidth is available, and the 
remote client will see better quality video.  The bit rate is decreased if packet loss increases, and less 
bandwidth is available.  Bit rate is only adjusted based on the network bandwidth available 

Sametime 

Video Chat: Automatically adjusting send resolution  / frame rate 
If the client machine the video engine is running on has a CPU usage rate consistently displayed above 
95%, the Sametime Video Engine will automatically adjust the frame rate and the send codec resolution.  
The opposite is also true: if more CPU is available, the Sametime video engine will try to send out at a 
higher frame-rate and better resolution, up to the maximum resolution specified in Preferences. 

Sametime 

Video Chat: CPU Usage 
Expect high CPU usage when using Video Chat, since grabbing video frames and encoding them into 
H263 format is a CPU-intensive operation.  In addition, the CPU is encrypting /decrypting these packets, 
and decoding the video frames. 

Sametime 

Voice chat and Network Address Translation  (NAT)

The Sametime 7.5.x voice chat component provides Voice over IP (VoIP) services.  To work correctly, 

voice chat needs to have the network configured properly.  Voice chat works with UDP packets; it needs

UDP ports to be opened on the firewall of every 7.5.x client. The clients are using a single port (UDP port 

20830) for all audio chats; this port needs to be opened for both incoming and outgoing UDP traffic.


Voice chat operates in two different modes:


z	 Direct P2P connection: UDP packets flow directly between users 
z	 Reflector connection: UDP packets go through an audio proxy, called a "reflector", which is a 

piece of code installed with the Sametime 7.5.x server 

In both modes, the firewall needs to let the UDP (port 20830) traffic flow in both directions.  The direct P2P 
connection is used whenever possible, and is the recommended way of using voice chat. 

The reflector mode is only used when a specific type of NAT (symmetric NAT) is detected.  In that case, 
since both clients are unable to guess each other's IP address to establish a P2P connection, the UDP 
packets are relayed through the reflector. 

This mode is used for compatibility; performance will not be as good as direct P2P.  Consequently, the 
user could experience additional delays, and a decrease of quality in the voice chat, depending on the 
Sametime 7.5.x reflector availability. 

For NAT environments, the reflector will be used.  The reflector uses 2 TCP/UDP ports: 

- 20831
- 20832
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Those ports must be opened for incoming and outgoing UDP and TCP traffic, on the reflector machine.  It 
is recommended that the reflector machine have a static IP address. 

In case the reflector is running on multiple network interfaces, it must be configured with either a 
hostname or an IP address, so that clients know which address to use to connect to the reflector. 

For example, in the [STReflector] section of the sametime.ini file 

STREFLECTOR_SERVER_NAME=reflector.domain.com 

or 

STREFLECTOR_SERVER_NAME=192.168.1.1 

If the reflector is located in an environment with two different subnets, the reflector needs to be accessible 
from different networks, hence the property STREFLECTOR_SERVER_NAME should be a fully-qualified 
hostname, which resolves to the appropriate addresses in both networks/subnets. 

In case the 7.5.x client is running against a pre-7.5 server, the voice chat component may not work 
correctly in a number of cases: 

z	 The client has multiple network interfaces (in that case, the 7.5.x client might get confused as 
to which interface should be used) 

z	 The client is sitting behind a router/NAT 

The symptoms experienced by the client in these cases is that one (or both) of the parties in the voice 
chat will not be able to hear each other, even though the chat window will show a "connected" status.  To 
confirm the problem, the user can increase the log level of the client to FINE, and look in the log for 
entries related to "reflector".  The IP detection problem will be signaled. 

The 7.5.x client has the ability to host calls with up to 5 participants, including the host.  During such calls, 
the host is the creator of the call.  The host will mix the audio streams for each participant.  Consequently, 
the host will have up to 4 incoming/outgoing audio streams, which will multiply the amount of bandwidth 
necessary.  It is recommended that for multi-party voice chats, the client with the most bandwidth hosts 
the call. 

Sametime 7.5.x is using the iSAC codec for all voice chats.  This codec is an adaptive bandwidth codec, 
which requires between 10.6 to 28.8 kbits (headers included), depending on the voice activity and the 
network quality. For example, during a 3-way call, the host will require twice that amount (between 21.2 
and 57.6 kbits), both incoming and outgoing.  The other 2 participants, will only require between 10.6 and 
28.8 kbit/s. 

The CPU requirement for hosting calls is 'medium': a 1GHz machine can easily mix a 3-way call; a 2GHz 
machine can mix a 5-way call easily.  During a voice chat call, the Sametime process is running at high 
priority under Windows (regular priority under Linux), because voice processing needs to be real-time to 
avoid quality issues. After the call terminates, the process goes back to normal priority. 

If the user drags windows around (especially chat windows), or does some other activity which is either 
CPU or network intensive, the quality of the call will decrease.  The codec will try to automatically recover 
when conditions improve. This process can take a few seconds. By pausing/resuming their calls (by 
clicking the "pause" / "resume" button on the audio toolbar of the chat window), the user can force a 
"reset" of the call quality; this is equivalent to ending and starting a new call. 

It is recommended that you disable or reduce any download or other CPU-intensive activity during a call, 
in order to obtain maximum quality.  Network administrators might want to mark the UDP packets from 
port 20830 with a higher class of service in order to increase voice quality. 
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Uninstallation information 

Sametime Gateway 

Uninstall on AIX when only Application Server is selected 
There is a known issue on the AIX platform during uninstallation if only the WebSphere Application Server 
feature is selected to remove, and other components are not selected for removal.  The uninstaller will not 
remove the application server, but will report a successful removal.  It is recommended that users remove 
all features when uninstalling the product on AIX. 
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Known limitations, problems, and workarounds 

Limitations 

Installation issues 

Sametime 

Sametime Connect for Browsers is not included with Sametime 
Lotus Sametime Connect for Browsers is not included with Sametime 7.5.x.  If Sametime Connect for 
Browsers is needed for your Sametime 7.5.x installation, see technote 1243158, "Deploying Sametime 
7.0 Connect for Browsers on a Sametime 7.5 server", at: 

http://www.ibm.com/support/docview.wss?rs=203&uid=swg21243158 

Sametime 

Use only ASCII characters for client installation path 
There is a known problem with installing the Sametime Connect client to a path that includes DBCS 
characters, for example, Chinese, Japanese or Korean.  Please use only ASCII characters when 
selecting an installation location for this release. 

Sametime Gateway 

Warning dialogs do not handle ')' correctly 
When running the installation program, strings that contain the ')' character are not handled appropriately 
when a warning is shown to the user that includes the entered string.  This may result in truncated 
warning messages that do not tell the user the entire cause of the validation error. 

Client issues 

Sametime 

Cannot set voice chat audio devices on Macintosh clients 
The UIM client provides the ability to configure the desired voice chat audio devices in the Preferences 
window. In this release, this configuration is not possible for Macintosh clients.  Configuring audio devices 
on the Macintosh platform must be done through Apple OS preferences. 

Sametime 

Features not available with pre-7.5 server configurations 
When using the Sametime 7.5.x Connect client in environments that have pre-7.5 servers, the following 
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features will not be available: 

1. Business cards with extended user information and pictures 

2. Selective 'Do Not Disturb' 

3. Automatic "In a Meeting" status change when in meetings 

4. Support for voice chat in configurations with NAT 

Sametime 

How Policy affects client-to-client telephony 
In client-to-client telephony, a user who is not permitted, through Policy assignment, to make a 
client-to-client call, is also unable to receive a call from a user who is Policy-enabled to place a call.  
When a Policy-enabled user (User 1) initiates a call to a non-Policy enabled user (User 2), the Call icon is 
disabled when User 2 is selected.  In addition, when User 1 selects a group of which User 2 is a member, 
User 2 can be listed in the ‘Start a call’  window, but User 2 cannot receive the invitation.  This is the result 
of strict enforcement of Policies in 7.5.1.  

In a related scenario, a user who logs in from a pre-7.5 client such as Sametime 6.5.1, a Notes client, or a 
Meeting Room Client, cannot respond to a call initiated by a user who is logged in to a 7.5.x client. 

Sametime 

Linux: Automatic Reconnect not working 
Automatic reconnect when losing network connectivity in the Linux Connect client does not work.  This 
feature works only on the Windows connect client. 

Sametime 

Orange frame used as a selection aid is not drawn on Linux 
When using Linux, Sametime does not draw an orange frame around the application that is highlighted in 
the Sharing dialog. 

Sametime 

Possible Linux sound issues with OSS 
Sametime Connect 7.5.x for Linux ships with OSS by default.  If other application are using OSS, the 
Sametime Connect client may not be able to play sounds or participate in voice chats.  This is a known 
OSS issue regarding applications sharing the system sound correctly. 

Sametime 

Running in a hybrid environment with pre -7.5 clients 
The Sametime Connect 7.5.x client can run in an environment with a mixture of new and old Sametime 
clients.  Note that you will not be able to send rich text to pre-7.5 clients, and that the rich text tools will be 
disabled in such a client. Also note that when switching to "In a Meeting" status, you will be seen by older 
clients as "Online" with no status icon. 

Sametime 

Sametime Connect client accessibility issues 
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Note the following issues that may affect users who have a physical disability, such as restricted mobility

or limited vision:


z	 Do not turn on the tabbed chat window for multiple chats feature (by selecting File -> Preferences, 
clicking Chat Window, and selecting Use tabbed windows for multiple chats .) Screen readers do not 
always correctly read the user interface for this feature. Please note that this feature is turned off, by 
default. 

z	 In the chat window text message entry field, it is not possible to select another background or 
foreground text color using keyboard shortcuts.  The selected color does not take effect.  Instead, in 
the chat window, use the Edit > Text Properties menu to do this. 

Sametime 

Some network connectivity options not available on Linux Connect

The Linux Connect client does not support the following connectivity options, and they will not work even

though they are shown as available:


1. HTTPS proxy 

Sametime 

Voice/video chat doesn't show that participant unmuted himself

If a voice or video chat participant unmutes himself after being muted by the call moderator (initiator), the 

Lotus Sametime Connect user interface will continue to show the participant as muted, even though 

everyone can now hear him. This problem will be addressed in the next Sametime Connect release.


In the meantime, do not rely on the user interface to correctly indicate your mute status. Ask others on the 
call if they can hear you before saying anything that should not be heard by others. 

Contact issues 

Sametime 

Click-to-call only works with primary community

You can only use the click-to-call capability if that feature is enabled for your primary community, even if

you log in to other communities where that feature is enabled. This restriction does not apply to voice

chat.


Sametime 

"$" character in business card retrieving data from Domino LDAP 
Domino LDAP adds the "$" sign to the postalAddress attribute.  Therefore, when users' details are 
being retrieved from Domino LDAP, the value for Location contains "$" signs.  Since the value of this field 
is a concatenation of 3 other fields in the Name and Address Book (City, State/Province, and Country), a 
possible workaround is to fill only one of these fields. 
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Internationalization issues 

Sametime 

Click To Call may not work correctly for Turkish locale 
For a Turkish locale setting, Click To Call may not work as expected. 

Sametime 

Linux: Date displays incorrectly for Login page

If running on Linux, the date or time may display as unreadable characters from the Administration -> 

Monitoring -> Login page.


Meeting issues 

Sametime 

Conversion Service failure produces no error message 
In Sametime 7.5.x, the Conversion Service can be configured in such a way that conversion takes place 
on a remote server.  If, for some reason, a connection cannot be made to this remote server during the 
conversion process, the user will not see any error messages on the screen - the only symptom will be 
that a file is not attached to the Whiteboard.  A detailed error message, however, will be printed in the 
logs. 

Sametime 

Directory dialogs do not show a user 's online status 
The Directory and Invite dialogs do not correctly show added users' online status.  A previous issue with 
not showing a user's capabilities (video camera, speakers, microphone) has been fixed. 

Sametime 

Dual monitors not supported 
The Screen Sharing feature in online meetings does not support dual/multiple monitors.  Only data on the 
primary display/monitor can be shared. 

Sametime 

IME may disappear when XP users share entire screen 
If the Input Method Editor (IME) is not minimized in a taskbar, it may sometimes disappear when XP users 
share their entire screen in a meeting. 

Sametime 

In meetings, user cannot start chat with  7.5 or earlier user 
Sametime 7.5.1 contains a new user chat policy that prevents 7.5.1 meeting participants from starting 
instant messages with users whose community services are being provided by an older Sametime server. 
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Sametime 

In telephony, Mute may not work as expected 
When using telephony, the Mute features may not work as expected, depending on how the audio bridge 
responds to the Mute requests. 

1. When the moderator chooses "Mute All", a mute with lock may result on everyone in the meeting 
except the moderator.  If any users need to be unmuted, the moderator must unmute those users. 

2. When a user mutes himself, a mute with lock may result.  If this user needs to be unmuted, the 
moderator must unmute the user. Furthermore, anytime a user mutes himself, the moderator may 
unmute the user at any time. 

Sametime 

Linux: Meeting page may overlap with frame border 
If you are using Mozilla on Linux, the meeting page may overlap with the frame border. 

Sametime 

Password is not case-sensitive using Mozilla with RedHat 3.0

When using a Mozilla browser to create a password-protected web conference, running with RedHat 3.0, 

the meeting password is not case-sensitive.


Sametime 

Preferences/Status Messages - In a Meeting settings 
In the Status Messages section of Preferences, the settings for "In a Meeting" do not consistently occur if 
the user changes the status by entering an online meeting from a community that is not the primary 
community. The primary community is the first one the Sametime Connect client was set up with. 

Sametime 

Premiere Global Services audio adapter not supported 
The IBM Lotus Web Conferencing Audio Adapter for Premiere Conferencing (now Premiere Global 
Services) for Lotus Sametime 6.5.1 and Lotus Sametime 7.0 is not supported for Lotus Sametime 7.5.x.  
For information on how to connect Lotus Sametime 7.5.x with audio services from Premiere Global 
Services, please visit: 

http://www.premiereglobal.com/ilwc/ 

Sametime 

Set maximum number of days for Web Conferences in Notes .INI 
Administrators can limit how far in the future a web conference can be scheduled. This setting cannot be 
set from the Sametime Web Administration application, but instead must be configured in the Notes.INI 
file of the Sametime server.  Administrators should set the parameter in the Notes.INI file as follows: 

STScheduleLimitDays=10 

The value of this parameter is the number of days in the future that a Web Conference can be scheduled 
to end. By default there is no limit, and setting this limit will cause a JavaScript alert box to pop-up when a 
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user tries to schedule a web conference that ends more than the specified number of days from the 
current server time. This check is done only on the client at the time a web conference is scheduled, 
therefore existing web conferences will not be affected. 

Sametime 

Some German characters may not work in shared application 
Sometimes, when a remote user inputs special German characters into a shared application during a 
Sametime meeting, the application may not work correctly. 

Sametime 

StarOffice Calc and Impress files cannot be attached 
Sametime Web Conferences do not support StarOffice Calc (.SXC) or StarOffice (.SXI) Impress files on 
the Whiteboard. These file types can be attached to the meeting, however, only the text will be converted 
for viewing in the meeting. 

Sametime 

The date/time format in unlisted meeting pages is unlocalized 
When searching for an unlisted meeting, the date/time format in the search results may not follow a 
language-specific format. 

Sametime 

When shared window is obstructed users will see gray 
When a user is Screen Sharing an application window in a meeting, and that window is obstructed by 
another application/window, participants in the meeting will see the shared area grayed out.  This is a 
security feature, to ensure only the desired application is visible to meeting participants. 

To avoid this problem: 

1. Make sure your shared window/application is not obstructed by another window/application. 

2. Use either "Share a resizable frame" or "Share Desktop", in which case the frame or desktop 
cannot be obstructed. 

Sametime 

Year/Month format is not localized in Calendar dialog 
The Year/Month format may not follow a pre-determined, language-specific format in the Meeting center 
Calendar dialog. 

Sametime 

"Join the Call" button may take a few moments before enabling 
When using the Telephony tools in an online meeting, it is possible for the "Join the Call" button to take a 
few moments after successfully connecting to the telephony service provider to become enabled.  This is 
a factor of how quickly the Telephony Service Provider (a third-party component) notifies the Meeting 
Room Client that a user may join the call. 

Be patient after entering the telephony service provider required information; the "Join Call" button will be 
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enabled. 

Sametime Gateway issues 

Sametime Gateway 

Silent install on i5/OS produces incomplete installation log 
During the installation of the Sametime Gateway the installer will call several QSHELL commands as part 
of the installation procedure.  Typically the results of running these commands are written to the 
installation log.  However, when an installation is performed using a response file and the -silent mode, 
the results of running the QSHELL commands are not written to the log, resulting in an incomplete record 
of what occurred during the installation. 

Sametime Gateway 

Emoticons convert to text symbols using Connect and UIM clients 
Emoticons can be sent and received between UIM and UIM clients, but are converted to text symbols 
when they are sent from a UIM client to a Sametime Connect client.  If a user sends text symbols by 
means of a Sametime Connect client, then the text symbols are converted to emoticons. 

Sametime Gateway 

External user does not receive status messages 
If the "user consent" framework is enabled on a Sametime server, external users will not receive status 
messages about the Sametime user with whom they are chatting.  Please see "Internal user consent for 
external users" in the Configuration section of these release notes for more information on the user 
consent framework policy. 

Sametime Gateway 

Known issues with Sametime Connect and Yahoo ! Messenger 
Sametime does not support offline messages. As a result, when a Sametime user chats with a Yahoo! 
user and the Yahoo! user goes offline, the Sametime user can continue chatting and is not notified that 
the message can only be delivered when the Yahoo! user is online. 

Sametime Gateway 

Offline messages, Do Not Disturb status not handled correctly 
When an internal user exchanges Instant Messages with an external user, and the external user's chat 
status changes to "Do Not Disturb", the typing area will be greyed out, and typing will be disabled.  When 
working with the Sametime Connect Client and the external user changes their chat status back to 
"Active", the typing area will still be greyed out. 

Workaround 

z The internal user should open a new chat window to the external user. 

z Upgrade to the UIM client. 
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Sametime Gateway 

Sametime capabilities are limited with external users 
The Sametime Gateway supports awareness and instant messaging with external communities.  Other 
Sametime features, such as file transfer, n-way chat, and voice-chat are not available with external users.  
Some options, such as rich text, are disabled when chatting with an external user.  If a user tries to send 
an emoticon, it is converted to a text symbol, such as :-). 

Sametime Gateway 

Sametime Gateway has limited NAT support 
Network Address Translation (NAT) is supported between local Sametime community servers and 
Sametime Gateway 7.5.1, but NAT is not supported between Sametime Gateway and the Internet, 
because of a limitation in the SIP protocol. 

A NAT-enabled firewall does not work with some Internet protocols, including the SIP protocol, which 
Sametime Gateway uses to exchange messages with AOL Instant Messenger™, Yahoo! Messenger, and 
other Sametime communities.  However, NAT has no affect on the XMPP protocol, so exchanges using 
Google Talk over XMPP would be permitted to pass through a NAT-enabled firewall that is between 
Sametime Gateway and the Internet. 

Sametime Gateway 

Sametime servers 3.0, 6.5.1, and 7.0 require a SIP patch 
Sametime servers 3.0, 6.5.1, and 7.0 require a SIP patch to connect to Sametime Gateway.  A patch is 
available from Lotus Support, so you can successfully connect Sametime Gateway to external Sametime 
3.1, 6.5.1, or 7.0 servers. These patches need to be applied to older Sametime servers in external 
communities. 

Sametime Gateway 

XMPP does not support Sametime Gateway clusters 
You cannot use the XMPP translation protocol to connect to a Google Talk community over a Sametime 
Gateway cluster. Use a single Sametime Gateway server if you want to set up a connection with the 
Google Talk community. 

Server issues 

Sametime 

Do not create a Name Change Task with a non -existent file 
When creating a new Name Change Task, if you use a non-existent file, the function may not react 
correctly and return JavaScript errors. 

Sametime 

Domino Web Administration does not support Firefox  1.5.x 
When using Mozilla Firefox 1.5.x to access Sametime Web Administration, the linked Domino Web 
Administration does not support using Firefox 1.5.x; only Firefox 1.0.x is supported by Domino. 
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Sametime 

Internet e-mail addresses not supported in LDAP attribute 
If a Sametime server is setup to use an LDAP directory, there is an optional setting in stconfig.nsf 
that specifies the LDAP attribute to use for the internal Sametime ID of a user.  This setting cannot contain 
an LDAP attribute that holds the internet e-mail address for users.  If it does, then web conferences that 
are restricted to certain users will not work properly, and other user-restriction related features may be 
broken in Sametime. 

Sametime 

No test or self-signed certificates for HTTPS proxy connections

The Sametime client supports using HTTPS proxy connections (forward or reverse).  However, when 

using HTTPS connections, the HTTPS server must be using certificates from a Root Certificate Authority.  

The Sametime client will refuse connections to HTTPS servers that use a test or self-signed certificate.  

Only valid certificates, from certificate authorities which can actually be authenticated, can be used.


Sametime 

Users appear offline logging into discrete nodes of a cluster 
Users in the buddy list are associated with a community; a community is unique, according to a hostname 
and user ID. Therefore, when logging into discrete hosts that represent a single, logical Sametime server, 
a new community is created for each one. Users associated with a particular community will only show 
awareness when logged into that community's host.  This may be avoided by simply changing the host 
value of the community in the login dialog or community configuration page to the desired target host. 

Known problems and workarounds 

Installation issues 

Sametime 

Sametime setup fails when xACL enabled for Domino Directory 
Currently, Sametime cannot be installed successfully when the Domino Directory (names.nsf) is 
configured to use an extended ACL (xACL). In order to install Sametime successfully, a customer must 
first disable xACL support for the Domino Directory.  After installing Sametime, the customer may then 
re-enable the xACL. Extended ACL support can be configured by opening names.nsf in a Notes client, 
navigating to File -> Database -> Access Control, and then clicking on the Advanced tab. 

Sametime Gateway 

Tab order problems in installation program 
When running the installation program, several panels do not exhibit tabbing behavior correctly and may 
skip certain buttons on the panel.  To get to all the buttons, use Shift+Tab instead. 
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Client issues 

Sametime 

Acrobat Reader must be installed for some autorun links to work 
The Autorun links for 'Release Notes', 'Installation Guide', and 'Administration Guide' will not work unless 
Acrobat Reader has been installed. 

Sametime 

Cannot click-to-call online users who run older Sametime clients 
When using the click-to-call feature to initiate a conference call with one or more users, you won't be able 
to call online users who aren't using Lotus Sametime Connect 7.5 or later. Users who are logged in to 
Sametime using older Sametime Connect clients, Lotus Notes clients other than Notes 8.0 Standard, or 
Sametime web conferencing cannot be called from Sametime Connect 7.5.x clients. This restriction does 
not apply to users who are not currently online. 

To work around this issue, you can call the users as external users, using Tools -> Invite to Call -> Start a 
Call. Add online users who are running Sametime Connect 7.5 to the invitation list, and then add other 
online users running different clients to the list using the Add New Person button. 

This limitation will be addressed in a future Sametime Connect release. 

Sametime 

Cannot rejoin conference call after hanging up phone 
When another Lotus Sametime Connect 7.5.x user invites you to a conference call using the click-to-call 
feature, and you accept the invitation, an n-way chat window appears that shows a telephony toolbar and 
the status of each call participant. 

If you leave the call by clicking the Hang Up button, the telephony toolbar in the chat window will 
disappear, and you will be unable to rejoin the call. If you leave the call by hanging up your phone, the 
telephony toolbar will remain visible, and the Hang Up button will be replaced with a Join Call button. 
However, clicking the Join Call button will not actually rejoin you to the call. 

To rejoin the call after you've left, either use the dial-in number if available, or ask one of the other call 
participants to re-invite you. 

Sametime 

Cannot start a call w/user whose policy does not allow telephony 
Users cannot initiate a call with a user whose policy does not allow telephony.  To work around this issue, 
create an external user in the Invite dialog using the "Add new person" button, with the number that you'd 
like to dial for that user.  The invitee will not get an invitation, but their phone will ring, and they can join 
the call. 

Sametime 

Corrupt .oit directory can cause conversions to fail on UNIX 
Infrequently, it has been observed that document conversions will fail for certain file types on all of the 
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UNIX/Linux platforms.   When this occurs, removing the .oit directory located in the user's home directory 
(the Notes user) will correct the problem. 

This is an issue in third-party software used in Sametime for document conversions.  The matter is being

investigated, and should be resolved in a future release.


Sametime 

Microsoft Office Integration : Re-enable Smart Tag

There are times when the Sametime options in the Microsoft Office Smart Tags suddenly stop appearing

in the Person Name drop-down action list.  These options include "(Lotus Sametime) - Open chat" and 

"(Lotus Sametime) - Open voice chat".  The affected programs are MS Word, Excel, and Power Point.


This occurs when a Person Name Smart Tag is triggered from an MS Office application, but there is

currently not a 7.5.1 Sametime Client running.  The Smart Tag requires a running 7.5.1 client in order to

launch chats, etc., and displays an error if a 7.5.1 client is not found to be running.  MS Windows then 

disables the Smart Tag.


To re-enable the Smart Tag, close all MS Office applications, launch the 7.5.1 client, and then run the 

following registry file from anywhere:


REGEDIT4 

[HKEY_CURRENT_USER\Software\Microsoft\Office\Common\Smart 
Tag\Actions\{80E9E20D-D9D0-448E-BFCA-EF9BA799FCD4}] 
"OpusApp"=-

Then open the MS Office application, and the "Lotus Sametime" menu items should be restored.  This will 
be fixed for the final product version. 

Sametime 

Unable to log in to Sametime from SUSE Linux client 
In Lotus Sametime 7.5.1 Beta 2, there is a known issue that requires a workaround to allow the Sametime 
Connect client to successfully log in to the Sametime server.  The workaround is to add your machine 
host name and IP address to the machine hosts file.  Following are the instructions: 

z Edit the /etc/hosts file.  This file contains a list of host entries in the form of: 

IP-Address Fully-Qualified-Hostname Optional Short-Hostname 

The first entry in the file is likely: 

127.0.0.1 localhost 

z Put your actual IP address and hostname above this entry, for example: 

9.33.34.35 myMachine.acme.com 

z Save the file and start Sametime 
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Contact issues 

Sametime 

Call menu item on right-click Person menu loses sub-menu

In some cases, the "Call" menu item (right-click Person menu) is enabled, but the sub-menu is missing.  

Simply right-click on the group name, and you will see the sub-menu displayed for the individual person, 

as well.


Sametime 

i5/OS: Update Business Card setup after changing to LDAP 
If you use the CHGLSTDOM command on i5/OS to change your Sametime server from using a Domino 
Directory to an LDAP directory, an additional step is required for the Business Card feature to work.  

You must use the Sametime Administration tool to update the Business Card Setup. 

1. Select "Administer the server." 

2. Expand the plus sign next to Configuration in the contents pane. 

3. Select Business Card setup. 

4. Update the setup so that it contains the correct Attribute values for your LDAP directory. 

For example, the default values that Sametime uses for an LDAP directory are shown in the table below. 
Your attribute values may be different for your particular LDAP directory configuration. 

Attribute name Attribute value 

Address postalAddress 

Company ou 

E-mail address mail 

Name cn 

Photo jpegPhoto 

Telephone telephoneNumber 

Title title 

Sametime 

Preventing errors when UserInfo servlet processes updates 
To prevent errors when the UserInfo servlet processes updates that are generated by Administrator 
changes, the following steps are required: 

1. In the file UserInfoConfig.xml, set the value property of the "ReadStConfigUpdates" tag to 'True' 

2. Restart the HTTP service 

Note: This issue affects only Sametime servers that are configured to work with a Domino directory. 
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Sametime 

Retrieving Photos from Domino 6.5.1 LDAP directory with UserInfo 
Binary data cannot be correctly retrieved from a Domino 6.5.1 LDAP  Directory, therefore, if UserInfo is 
configured to retrieve data from a Domino 6.5.1 LDAP directory, the photos will not be retrieved.  To 
successfully retrieve photos from a Domino LDAP directory, the directory should be upgraded to Domino 
6.5.4 or higher, where this issue has been addressed. 

Sametime 

Setting the company name for Domino LDAP 
To display the company name in the business card when the Sametime server is pointing to a Domino 
LDAP directory, use a third-party LDAP management tool to add a value to the LDAP "ou" attribute.  The 
Name and Address Book contains a hidden field for the LDAP attribute "ou", which can not be set through 
the Name and Address Book. 

Internationalization issues 

Sametime 

Do not use Japanese characters in client plug -in download path 
In the Sametime Connect client Update Manager, users may experience an error when using Japanese 
characters as part of the plug-in download path.  Do not use Japanese characters in the download path. 

Sametime 

Do not use the Euro symbol in an attachment name 
The Sametime service may be adversely affected if you attach a file with the Euro symbol (€) in the 
filename.  Do not use the Euro symbol in an attachment filename. 

Sametime 

Euro symbol may display incorrectly 
If a recorded meeting name contains the Euro symbol (€), the symbol may display incorrectly in the 
confirmation message users see when the delete a meeting. 

Workaround 
Enable UTF-8 in the Domino server document. 

Sametime 

i5/OS: Server fails to start when CCSID incompatible with PASE 
If the Sametime server is using a CCSID that is incompatible with PASE (the Portable Application Solution 
Environment), then PASE will fail to start. This causes the Material Manager service to fail and the 
Sametime server will not start. 

The following messages appear in the server console: 

Sametime: Starting Service Material Manager 
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Sametime: Meeting Server: child process died! Ending server. 

To determine whether your problem is caused by using a CCSID that is incompatible with PASE, check

the IBM eServer iSeries Information Center (

http://www.ibm.com/eserver/iseries/infocenter) which provides a table of the supported PASE Locales.

(To locate this table in the info center, search for 'PASE locales'.)  


If your server is using a CCSID that is not listed, then you can run several commands to set the PASE

language environment. 

For example, if you are using a Russian CCSID other than 915 or 1208, then your CCSID is incompatible

with PASE. Run these commands to set the PASE language environment for one of the supported

CCSIDs (in this example, the language short name is 'ru_RU' and the CCSID is 1208):  


ADDENVVAR PASE_LANG 'ru_RU' LEVEL(*SYS)

ADDENVVAR QIBM_PASE_CCSID 1208 LEVEL(*SYS)


If the problem is not caused by an incompatible CCSID, then it may be the result of a corrupted PASE 
installation. Reinstall PASE (5722SS1 Option 33). 

Note: To verify that the Material Manager failed due to a problem with PASE, check whether there are 
PASE errors associated with the STMATERIAL job. 

1.	 Run the following i5/OS command: 

WRKJOB STMATERIAL 

2.	 Type option 1 next to the most recent STMATERIAL job, and press Enter. 

3.	 Select menu option 4: Work with spooled files. 

4.	 Open the spooled files and look for a message that indicates there was a problem starting

OS/400 PASE.


Sametime 

International characters on slides may not display correctly 
In addition to remote Conversion Services, Sametime 7.5.1 for i5/OS also supports running Conversion 
Services as an integrated function of your Sametime server.  However, some international characters on 
slides may not render correctly when using integrated conversion services.  If this is a problem in your 
environment, it is recommended that you configure a remote conversion server instead. 

More information about Sametime Conversion Services is available in the Server Administration section of 
the Sametime Information Center. See "Configuring the Meeting Services." 

Sametime 

Linux: Square symbol may appear 
You may sometimes notice a misplaced, square-shaped symbol, for example in the Meeting Room Client. 

Workaround 
Using Traditional Chinese in the following example, perform these steps: 

1.	 Open the file ~/JAVA_HOME/lib/font.properties.zh_TW.Redhat. If you can see the string: 

filename.-arphic_technology_co.-ar_pl_mingti2l_big5-medium-r-normal--*-%d-* 
-*-c-*-iso10646-1=/usr/share/fonts/zh_TW/TrueType/bsmi00lp.ttf 

you need to add the file bsmi00lp.ttf to the path /usr/share/fonts/zh_TW/TrueType/ 

69 

Download from Www.Somanuals.com. All Manuals Search And Download.



IBM Lotus Sametime 7.5.1	 Release Notes 

2.	 Copy /usr/share/fonts/zh_TW/TrueType/* in RedHat to the same path in SUSE.  If SUSE 
doesn't have this path, please create it. 

3.	 In ~/JAVA_HOME/lib/, input cp font.properties.zh_TW.Redhat 
font.properties.zh_TW 

4.	 In ~/mozilla/ , input export LANG=zh_TW LC_ALL=zh_TW , then input ./mozilla 

Sametime 

Macintosh: Client may not show native UI for Norwegian locale 
The Sametime Connect client Update Manager may not show the native UI for a Norwegian locale on the 
Macintosh. 

Workaround 
Add -Duser.language=no manually to the Sametime.INI file of the Sametime Connect client installed 
folder, and it will display the Norwegian UI. 

Sametime 

Users may see incoherent message when ending a meeting 
If UTF-8 is not enabled for web publishing in the Domino server document, the confirmation message 
when a meeting has ended may display as garbled, or incoherent, text. 

Workaround 
Enable UTF-8 in the Domino server document. 

Meeting issues 

Sametime 

After setting Call Properties , "Join the Call" may be disabled 
When joining a meeting that includes telephony, the user may need to enter the call properties before 
joining the call.  After entering the correct call properties, the "Join the Call" button may incorrectly remain 
disabled.  If the user leaves the meeting and rejoins, the "Join the Call" button is enabled. 

Sametime 

Cannot edit Telephony-based meetings 
Note: This release note applies only to the Sametime Enterprise Meeting Server. 

If you schedule a meeting that includes Telephony Options, you cannot later edit that meeting and remove 
the option. You can always add telephony to a scheduled meeting, but you cannot remove it once added. 

Workaround 
If you want to remove the telephony option from a scheduled meeting, delete the existing meeting and 
create a new meeting without telephony for the same time. 

Sametime 
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Disk space limits for recorded meetings 
Using the Administration tool to set limits on when to stop recording meetings has no effect on 
roomservers.  No known workaround exists at this time. 

Sametime 

Do not import a nonexistent recorded meeting file 
When importing a nonexistent recorded meeting file during a Sametime meeting, the import may not 
function correctly. Avoid importing a nonexistent recorded meeting file. 

Sametime 

Do not use certain characters in a meeting name 
If the following characters are part of a meeting name, the meeting name may not display correctly, or 
users may be unable to attend the meeting successfully: 

\ (backslash) 
' ' (single quotes) 
& (ampersand) 
µ (mu) 

Do not use these characters in a meeting name. 

Sametime 

Do not use certain characters in a meeting password 
If the following characters are used within the password of a password-protected meeting, users may see 
an error in their browser. 

\ (backslash) 
ø (slashed o) 
æ (ae dipthong) 
å (a angstrom) 
µ (mu) 
€ (Euro symbol) 
£ (Pound symbol)

  Do not use these characters in your meeting password. 

Sametime 

Do not use certain characters in password for recorded meeting

A Recorded Meeting may not playback correctly if you have used i18n (internationalized/localized) 

characters in the meeting password.  Do not use i18n characters in recorded meeting passwords.


Sametime 

Do not use double quotes in user name 
Logging in as a LDAP user whose name contains double quotes (" ") will cause an error.  Do not use 
double quotes in a user's name. 
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Sametime 

Invited Servers - 7.0 to 7.5.x whiteboard pointer discrepancies

With a Sametime 7.5.x and Sametime 7.0 invited environment, there can be discrepancies in the 

whiteboard tool's pointer icons.  In Sametime 7.5.x, the pointer tool was replaced by a new "stamp" tool.  

The previous whiteboard pointer tool allowed for selection from a variety of images; with Sametime 7.5.x, 

only one stamp image is available.


When a 7.0 user places various pointer images on the whiteboard, they will appear on the 7.5.x 

whiteboard correctly, with the exception of the image of the "pointing finger"; this will appear as the stamp

image instead (a gold star).


Sametime 

Linux - Crash when using the IBM JVM 1.4.2 with Firefox 
With certain configurations on Linux, using the IBM JVM 1.4.2 and the Firefox browser, the Meeting Room 
Client can crash. 

The Firefox help indicates that it is built with gcc3.2, and that any Java plug-in to be used with Firefox 
must also be built with gcc3.2.  The standard libjavaplugin_oji.so that is linked to the Firefox 
plug-ins directory is not built with gcc3.2 in IBM's distribution; you must link the 
libjavaplugin_ojigcc3.so instead. 

From the Firefox plug-ins directory, execute the following command: 

ln -s /opt/IBMJava2-142/jre/bin/libjavaplugin_ojigcc3.so 
libjavaplugin_oji.so 

With this change, the Meeting Room Client loads successfully, and the browser will not crash. 

Sametime 

Some .SDD files cannot be converted and attached to a meeting 
In the current release of Sametime, certain .SDD files are unable to be converted and added to a meeting.  
This issue has been reproduced with StarOffice Impress and OpenOffice Impress .SDD files; this is a 
thrid-party software problem related to the Stellent filters in the Conversion Service. 

When this issue occurs, the user will not see any error messages - the only symptom is that the file will 
not show up on the Whiteboard. Error messages are, however, printed in the logs. 

Sametime Gateway issues 

Sametime Gateway 

Invalid blacklisted wildcards on Properties page 
In the Integrated Solutions Console, the blacklist domains field on the Sametime Gateway properties page 
does not properly handle invalid wildcard domain strings.  Wildcard domains must start with '*.' and must 
not contain two or more asterisks together. For example, "*domain.com" and "*.domain**.com" are not 
allowed, but "*.domain.com" is allowed. 

If you type an invalid domain name, you receive an unexpected application error message. The invalid 
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domains are not saved, but will reappear until you log out and then log back in to the Integrated Solutions 
Console. 

Sametime Gateway 

Pre-7.5 Sametime clients are not licensed for use 
Lotus Sametime client users must use the Sametime client version 7.5 or newer only when exchanging 
instant messages and presence information with public instant messaging providers such as AOL Instant 
MessengerTM, Yahoo Messenger

®
, and Google TalkTM. Pre-7.5 clients are not licensed to connect with 

public instant messaging providers. It is the responsibility of the Sametime Gateway administrator to 
comply with the Lotus Sametime Gateway license agreement and the Lotus Sametime Lotus Sametime 
license agreement. To help you enforce the license agreement, you must explicitly assign local users 
access to the external community, using the Integrated Solutions Console, in order for users to exchange 
instant messages and presence with users of the external community. 

As an administrator, you must first determine that the users to whom you give access to public instant 
messaging providers have upgraded or installed the Sametime 7.5 or 7.5.1 client. You then grant access 
only to those users only by selecting them from using the Assign Users option on the Community > 
Assign Users page. Because the list of users will likely grow over time, IBM recommends that you create 
an LDAP group of Sametime 7.5 client users in the enterprise LDAP directory for this purpose, and grant 
access to the group instead. This group can have either individual users or other groups as members. 
Members of this group can then be granted access to a specific public instant messaging provider. 

Sametime Gateway 

URLs displayed twice 
When an AOL® user sends a URL in an instant message, the URL is displayed twice. The first instance 
may not always be clickable or navigate to the correct site.  Click on the second instance to navigate to 
the correct URL. 

Server issues 

Sametime 

AIX - Domino fails to connect to LDAP server with SSL via DA .nsf 
This issue is related specifically to Domino 7 on AIX.  The LDAP SSL works with the same steps on both 
Windows and Solaris when the "Verify server name with remote server's certificate" option is enabled.  It 
only works with Domino 6.5.1 on AIX. 

The workaround for the Domino server is to disable the "Verify server name with remote server's 
certificate" option in the DA.nsf database. 

Sametime 

Conversion Service and files with wrong extensions 
When file types have been renamed using a different (incorrect) extension, the conversion service will 
attempt to convert the file with the incorrect extension.  This may result in the conversion service 
producing a large number of incorrect converted images in the converted directory. 

These images will eventually be cleaned up, but the process of creating the images may take a long 
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period of time to complete, in which the conversion service will appear non-responsive.  The process will 
end, however. 

Sametime 

On i5/OS (iSeries) some DBCS usernames may not log in correctly 
Using i5/OS (iSeries), a user with DBCS characters in the user name may not log in correctly. 

Workaround 
Run the "tell adminp process" command in from the Domino console.  Note that some DBCS user names 
are still not able to log in after running this command, for example, 王, 密密, 瞳. 

Sametime 

Policy Assign Users incorrectly says to select a directory 
The Policy Assign Users page incorrectly says to select a directory to add people / groups.  The Policy 
Assign Users applet searches all directories that are configured for Sametime. 

Sametime 

Policy Assign Users pages does not detect Java VM 
When accessing the Policy Assign Users page, a supported Java VM is required. The page does not 
correctly detect whether a supported JVM is installed. 

Sametime 

Quick find behavior when Sametime server uses Domino LDAP 
The "quick find" option in the Sametime Connect client should be used differently if the client is connected 
to a server that uses Domino LDAP. To find a name using the quick find option, type the whole name to 
get the requested result; typing only a few characters of the name is not enough. 

Sametime, Sametime Gateway, Sametime Mobile 

STPolicy Server Application trace file size decreasing 
When VP_TRACE_ALL=1 key is provided in the [Debug] section of the sametime.ini file, the STPolicy 
Server Application size becomes huge. To avoid this, the following workaround is provided: 

If sametime.ini contains the POLICY_DEBUG_LEVEL flag in the [Debug] section, STPolicy trace is 
generated according to the key value (0 to 5), even if VP_TRACE_ALL=1 flag appears. 

If POLICY_DEBUG_LEVEL is not provided and VP_TRACE_ALL=1 flag is added, the highest debug level 
(5) is applied for STPolicy. 

If neither the POLICY_DEBUG_LEVEL flag nor the VP_TRACE_ALL flag appears, the least STPolicy 
debug level (0) is applied. 

Sametime 

STReflector Service not listed in Admin Services overview list 
When you choose the "Administer the Server" link on a Sametime 7.5.x server, you'll see a list of 
processes running on the server; the STReflector service is not listed there. 
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To verify if the STReflector process is actually running on the server, go to the Windows task manager, 
and look for the "streflector.exe" task in the list.  If it is listed there, the service is running. 

You can also choose Administrative Tools -> Services from the Control Panel, and see the "ST Reflector" 
service listed there with the status "Started".  Similarly for UNIX, obtain the list of running processes on 
the server and verify that streflector is one of them. 

Sametime 

Telephony Services unavailable after upgrading service provider 
An Avaya Service Provider upgrade may fail in the following scenario: 

1. Start out with Sametime 7.0 + Telephony Toolkit + Avaya Service Provider 7.0 
2. Upgrade to Sametime 7.5.x 
3. Upgrade to Avaya Service Provider 7.5 

In this case, telephony services may fail to start.  A user may see an error message such as 
"Configuration Lookup Failed" when trying to start a meeting (meetings will continue to work correctly, but 
no telephony services will be available).  This occurs because the Sametime 7.5.x upgrade overwrites 
some registry values that are needed for initializing telephony services.  When the telephony upgrade is 
performed, necessary actions will not be performed to restore these registry values.  If you have a 7.0 
Avaya Service Provider installed and wish to upgrade it, you must first uninstall the existing service 
provider. If you wish to also upgrade from Sametime 7.0 to Sametime 7.5.x, you must install 
the new service provider after Sametime has been upgraded. 

The steps for upgrading from Sametime 7.0 + Avaya Service Provider 7.0 to Avaya Service Provider 7.5 
are below: 
1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider
3. Upgrade to Sametime 7.5.x 
4. Install the new service provider
5. Reconfigure the service provider using your backups from (1) 

The steps for upgrading from Sametime 7.5.x + Avaya Service Provider 7.0 to Avaya Service Provider 
7.5 are below: 
1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider
3. Install the new service provider
4. Reconfigure the service provider using your backups from (1) 

Please be aware that configuration file formats between versions may change, so be careful when 
restoring backed-up configuration data.  To be safe, manually re-enter the configuration data using 
information from the backed-up files. 

See "Upgrading to Sametime 7.5.x breaks Avaya Service Provider" in these release notes for more 
information. 

Sametime 

Upgrading to Sametime 7.5.x breaks Avaya Service Provider 
Upgrading from Sametime 7.0 to Sametime 7.5.x will cause an existing Avaya Telephony Service 
Provider to stop working. An error message will indicate that "Configuration lookup failed" for telephony 
services when scheduling a meeting. This happens because the Sametime upgrade overwrites some 
registry values that are used to load the service provider.  An easy workaround is to back up your service 
provider configuration, uninstall the service provider, and then reinstall it.  If you have a 7.0 Avaya Service 
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Provider installed and wish to upgrade to Sametime 7.5.x, perform the following steps: 

1. Back up <Domino bin dir>/conference-adapter-configuration.xml and <Domino bin dir>/dial-plan.xml 
2. Uninstall the service provider. 
3. Reinstall the service provider
4. Restore conference-adapter-configuration.xml and dial-plan.xml 

The key is to uninstall the existing service provider and then reinstall it (or install a newer version) after 
Sametime has been upgraded. Please be aware that, if you install a newer version of the service provider 
(or upgrade it), configuration file formats may have changed.  See "Telephony Services unavailable after 
upgrading service provider" in these release notes for more information. 

Sametime 

Workaround available for URL redirection issues when tunneling 
When a Sametime server has been set up for tunneling over port 80, the Sametime MUX (STMux) is 
listening for port 80 traffic.  There are several situations where HTTP redirection is needed (STMux 
located on a separate machine, or when a reverse proxy is enabled). 

Traditionally, STMux handles HTTP redirect responses by stripping the Location host and keeping only 
the path. Using a redirect Location URL without a Location host is supported by most HTTP 
implementations. It is done here in order to avoid cases where redirections might direct the client so that it 
does not come through STMux. In some cases, however, the "guessed" complete URL is not the correct 
one. As a result, the browser on the client appears to be in an infinite loop where the web page never 
loads. 

For Sametime releases prior to 7.5 CF1, the only way for HTTP redirection documents to work correctly 
on a Sametime server is to not set up the Sametime server for tunneling over port 80. 

A fix is available in Sametime 7.5 Cumulative Fix 1 (CF1) and later that  offers an alternative approach. 
Instead of stripping the host[:port] from the URL, the customer can provide rules for translation from a list 
of host[:port] names to the host[:port] name which should be used instead. 

In order to take advantage of the fix, the customer must add several settings to the [Config] section of the 
sametime.ini file. 

For detailed instructions, see technote #1176728 ( 
http://www.ibm.com/support/docview.wss?rs=203&uid=swg21176728). 
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Documentation updates 

Installing the Sametime server 

Sametime 

Case insensitive awareness 
To change the default from case-sensitive awareness, add the following to the sametime.ini file to ensure 
case insensitivity is employed on all passwords: 

z	 In the CONFIG section, add:  AWARENESS_CASE_SENSITIVE=0 

z	 In the STLINKS section, append: -DAWARENESS_CASE_SENSITIVE=0 to STLINKS_VM_ARGS: to 
the following 
STLINKS_VM_ARGS=-Xmx128m -Xms128m -Xgcpolicy:optavgpause 
-DAWARENESS_CASE_SENSITIVE=0 

z	 STLINKS section (stlinks.js), add the following variable: 
var STlinksCaseSensitive=false; 

Note: Changing the default to case-insensitive awareness may have a small impact on performance.  

Domino Web Access, and Portal customers in some cases, may need this change.


Sametime 

Enabling Telephony support

When you install the Telephony Services on standalone Sametime Meeting Servers, Telephony is 

enabled by that action.  When adding these standalone servers to a Managed Meeting Cluster, you must 

enable Telephony so that the UI components show up, which allows users to add Telephony to their

meetings.


To do this, you will need to update the value for AUDIOBRIDGEENABLED in the

STCONFIG.ORGANIZATION table in DB2 from "false" to "true".  To do this:


From a db2 command window, issue the following commnands: 

z	 Connect to Sametime 
z	 Update stconfig.organization; set AUDIOBRIDGEENABLED to "true' and click Enter 
z	 Disconnect from Sametime 
z	 Restart the Enterprise Meeting Server and roomservers 

Sametime 

i5/OS: Updates to Installation Guide

Following are the updates to the Installation Guide when using i5/OS hardware:


z	 For i5/OS V4R5, it is not necessary to install 5722AC3, Cryptographic Access Provider 128-bit for 
iSeries. This product has been incorporated into the base operating system. 

z	 The required disk space listed in "Installing and Managing Lotus Sametime 7.5.1 for i5/OS" is 
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incorrect. The correct requirement is: 

1 GB required to run each Sametime server, 2 GB recommended; minimum of 4 disk 
drives (arms) 

Administering the Sametime server 

Sametime 

Client log file overview

By default, all generated metadata files, including log files, are located in <user.home>/Application

Data/Sametime, for example on windows, C:\Documents and Settings\<username>\Application

Data\Sametime.


1) <user.home>/Application Data/Sametime/sametime.log.{x}

The Sametime application log file.  Contains all log statements and exceptions handled by the Sametime

client. 


The numbers at the end of the log file are increased everytime a new client session is started.  The active 

client session is always sametime.log.0, the previous session becomes sametime.log.1, the one before 

that becomes sametime.log.2, etc.


2) <user.home>/Application Data/Sametime/.metadata/.log

The WED platform log file.  Contains log statements and exceptions handled by the WED platform.


Consult the ".log" file whenever the following dialog is shown:


This dialog is a WED dialog and typically means that an uncaught exception has occured, and "fallen 
through" to the platform.  

3) <user.home>/Application Data/Sametime/sametimeLaunch .log 
Sametime log file created for the initial application launch before the application log is initialized.  It is 
typically not needed in a problem report unless the problem is related to launching the application. 

Sametime 

LTPA token authentication 
The following release note applies to Community Services, allowing the user to authenticate: 

If the Sametime client sends a lightweight third-party authentication (LTPA) token with the organization 
parameter set to "null", the user will fail to log into the server.  Instead, send the token with the 
organization parameter as defined in the ST_ORG_NAME flag of the Notes.INI file.  This parameter should 
contain the organization name as defined in the Web Single Sign-On (SSO) document. 
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After you add the organization name to the SSO document, and add the flag ST_ORG_NAME=<name of 
organization of Web site that appears in Web SSO document>, then restart the server; 
the user can then input the User ID and password to log in. 

Sametime 

Sametime Connect plug-ins cannot install on locked-down desktop 
When the Sametime client downloads new or updated plug-ins during launch, or when the user manually 
installs plug-ins from an update site, the new plug-ins go into the plugins subdirectory of the directory 
where Sametime was installed.  In some environments, the user does not have write access to the 
program directory, making it impossible for the Administrator to deploy new plug-ins or fixes to the user. 

To remedy this situation, the Administrator can put plug-in updates in a location that the user will always 
have write access to, for example, the user's home directory. 

Note that when you run the product installer or silent installer as an administrator, this causes the program 
directory to be made read-only for users who don't have administrator privileges, so this problem is likely 
to exist in any configuration where the administrator installs the client for non-administrator users. 

Sametime Connect Client end -user Help 

Sametime 

Sametime Connect Client end-user Help updates/corrections 
The following list identifies corrections and other information related to the IBM Lotus Sametime Connect 
Client end-user Help: 

z	 The Help topic, "Accessibility features for IBM Lotus Sametime Connect," should include the 
recommendation to NOT turn on the tabbed chat window feature for multiple chats. This is 
because screen readers do not always correctly read the user interface for this feature. Please 
note that this feature is turned off, by default. 

z	 The Help topic, "Video calls" includes a note that this feature is not available on Linux. It is also 
not available on Macintosh. 

z	 Some icons in the Help about managing, viewing, and participating in telephone conference calls 
and video calls are incorrect.  Specifically, the Call, Call Options, Video, and Mute Video icons 
appear differently in the Help than in the product user interface. 

z	 The Help topic, "Automatically changing your availability status" describes how to specify on the 
Auto-Status Changes preferences page the situations in which your availability status 
automatically changes to another availability status. This topic does not mention that you can also 
automatically change your availability status based on events scheduled in your Lotus Notes or 
Microsoft Outlook calendar. To turn this feature on, select the Meetings scheduled in my calendar 
event on the Auto-Status Changes page and then click Calendar Service in the navigator. Then 
specify how often to check your calendar for scheduled events and, if you are using a Notes 
calendar, whether to use your Notes or Sametime password to check your Notes calendar. 

z	 The Help topics under "Plug-ins" describe how you can enable or disable and update plug-ins, 
including the ability to install plug-ins from a designated Web site.  The feature to install plug-ins 
from a Web site is not available in this release. In addition, there are no plug-in preferences in this 
release, as described in the Help topic "Setting plug-in preferences." 
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z	 Step 1 in the Help topic, "Configuring plug-ins" reads, "Click ToolsPlug-InsManage Plug-ins."  It 
should read, "Tools > Plug-Ins > Manage Plug-ins. 

z	 The Help about instant messaging communities mentions that if you have more than one instant 
messaging community, you must log into your default community before logging into other 
communities.  This is not true. You do not have to log into your default community before logging 
into others. 

Sametime Meetings end-user Help 

Sametime 

Meetings end-user Help updates/corrections 
The following list identifies corrections and other information related to the IBM Lotus Sametime Meetings 
end-user Help: 

z	 The Help topic, "Slides: Adding Slides to Display," identifies some incorrect information about the 
slide types that are automatically converted. The corrections follow: 

z	 OpenOffice Calc, versions 1.1, 2.0 (text , SDC) 
z	 OpenOffice Impress, versions 1.1, 2.0 (text, SDD) 
z	 OpenOffice Writer, versions 1.1, 2.0 (text, SXW) 
z	 StarOffice Calc versions 5.2, 6.x, 7.x, and 8.0 (text only) 
z	 StarOffice Impress 5.2, 6.x, 7.x and 8.0 (text only) 
z	 StarOffice Writer 5.2, 6.x, 7.x and 8.0 (text only) 

z	 The Help topics, "Allowing Others to Control the Shared Screen," "Ensuring Security," and "Using the 
Screen-Sharing Tools," refer to the "Allow Control" button. This button allows others to control your 
screen during screen sharing. These topics also refer to the "Reclaim control" button. This button 
allows you to reclaim control of your screen. 

z	 The Help topic, "Importing(Saving) a Recording of a Meeting," refers to "Secure this meeting by not 
listing it in the Meeting Center." This should be "Do not list this meeting (people must attend it with the 
URL or by searching for it by name)". 

z	 The Help topic, "Handling Permissions," refers to "Remove Permissons to All." This should be 
"Revoke Permissions for All". 

z	 The Help topic, "Monitoring the Length of the Meeting," refers to "Edit - Change Meeting Duration." 
This should be "Edit - Change Meeting Information". 

z	 The Help topic, "Options: Setting Meeting Options" refers to the check box, "People can attend from 
multiple external Sametime servers." This should be "People can attend from external Sametime 
servers". 

z	 The Help topic, "Repeating the Meeting" refers to the "How often the meeting repeats" field. This field 
does not appear in the user interface. Just select how often you want to repeat the meeting.  This 
topic also refers to the "Starting" field; this should be "Starting date". 

z	 The Help topic, "Shortcut Keys" refers to "Tools - Sharing - Let Other Control." This should be "Tools - 
Let Others Control My Screen". 

z	 The Help topic, "Starting a Breakout Session" refers to the "New Breakout" menu command and 
action bar icon. This should be "New Breakout Session". 

z	 The Help topic, "Tips for Arranging the Meeting Room" refers to "Sidebar tools." This should be 
"Sidebar tabs." In addition, this topic refers to clicking "Back to Standard View" in the floating window. 
This should be "Back to Meeting Room". 
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z	 The Help topic, "Why Is the Image in the Speaker's Video Window an IBM Lotus Sametime Logo?" 
refers to the "Play video" button. This should be "Play". 

z	 The Help topic, "Viewing Poll Responses Shared by the Chair" refers to the "Poll Tab." This should be 
"Polling". 

z	 The Help topic, "Viewing the Participant Who Is Speaking" refers to clicking "Pause Video." This 
should be "Pause". The topic refers to the "Recent Speaker".  This should be "Current Speaker".  The 
topic also refers to the IBM(R) Lotus(R) Sametime(R) logo displaying in the video window.  This 
should be the Video Meeting Paused icon displays in the video window. 

z	 The Help topic, "Accessing Meeting Details," refers to the "Expected connections" field. This should 
be "Expected participants". 

z	 The Help topic "Speaking During the Meeting," step 4 refers to "clicking the Audio Controls icon at the 
top of the participants list and clicking Release Microphone".   There is no Release Microphone 
command in the Audio Controls menu. 

z	 The Help topic "Attending a Breakout session" refers to clicking on an active (green) name in the 
participants list.  You can also click on the away (yellow) name. 

z	 The Help topic "Communicating with Computer Audio and Video" refers to the chair passing the 
microphone if a participant leaves the meeting without releasing the microphone.  This is unnecessary 
since the microphone is released automatically when you leave a meeting.   The same topic also 
refers to selecting Recent Speakers from the Show drop-down list at the top of the participants list.   
The Recent Speakers option only displays if the meeting is telephony enabled. 
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Notices and Trademarks 

Sametime, Sametime Gateway, Sametime Mobile 

Where to find notice and license information 
After accepting the license for this IBM product, you may view or print license files and notices by 
accessing the \license directory that is included with the installed product files. 

Sametime 

Notices 
This information was developed for products and services offered in the USA. IBM may not offer the 
products, services, or features discussed in this document in all countries. Consult your local IBM 
representative for information on the products and services currently available in your area. Any reference 
to an IBM product, program, or service is not intended to state or imply that only that IBM product, 
program, or service may be used. Any functionally equivalent product, program, or service that does not 
infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to 
evaluate and verify the operation of any non-IBM product, program, or service. 

IBM may have patents or pending patent applications covering subject matter described in this document. 
The furnishing of this document does not give you any license to these patents. You can send license 
inquiries, in writing, to: 

IBM Director of Licensing 
IBM Corporation 
North Castle Drive 
Armonk, NY 10504-1785 
U.S.A. 

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property 
Department in your country/region or send inquiries, in writing, to: 

IBM World Trade Asia Corporation Licensing 
2-31 Roppongi 3-chome, Minato-ku 
Tokyo 106, Japan 

The following paragraph does not apply to the United Kingdom or any other country/region where such 
provisions are inconsistent with local law: 

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE. 

Some states do not allow disclaimer of express or implied warranties in certain transactions; therefore, 
this statement may not apply to you. 

This information could include technical inaccuracies or typographical errors. Changes are periodically 
made to the information herein; these changes will be incorporated in new editions of the publication. IBM 
may make improvements and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 

References in this publication to IBM products, programs, or services do not imply that they will be 
available in all countries in which IBM operates. Product release dates and/or capabilities referenced in 
this publication may change at any time at IBM’s sole discretion based on market opportunities or other 
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factors, and are not intended to be a commitment to future product or feature availability in any way. 

Any references in this information to non-IBM Web sites are provided for convenience only and do not in 
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part 
of the materials for this IBM product, and use of those Web sites is at your own risk. 

IBM may use or distribute any of the information you supply in any way it believes appropriate without 
incurring any obligation to you. 

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 
exchange of information between independently created programs and other programs (including this 
one) and (ii) the mutual use of the information that has been exchanged, should contact: 

Lotus Software 
IBM Software Group 
One Rogers Street 
Cambridge, MA 02142 
USA 

Such information may be available, subject to appropriate terms and conditions, including in some cases 
payment of a fee. 

The licensed program described in this document and all licensed material available for it are provided by 
IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement, or by 
any equivalent agreement between us. 

Any performance data contained herein was determined in a controlled environment. Therefore, the 
results obtained in other operating environments may vary significantly. Some measurements may have 
been made on development-level systems, and there is no guarantee that these measurements will be 
the same on generally available systems.  Furthermore, some measurements may have been estimated 
through extrapolation. Actual results may vary. Users of this document should verify the applicable data 
for their specific environment. 

Information concerning non-IBM products was obtained from the suppliers of those products, their 
published announcements, or other publicly available sources. IBM has not tested those products and 
cannot confirm the accuracy of performance, compatibility, or any other claims related to non-IBM 
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of 
those products. 

All statements regarding IBM's future direction or intent are subject to change or withdrawal without 
notice, and represent goals and objectives only. 

This information contains examples of data and reports used in daily business operations. To illustrate 
them as completely as possible, the examples include the names of individuals, companies, brands, and 
products.  All of these names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental. 

Sametime, Sametime Gateway, Sametime Mobile 

Trademarks

IBM, the IBM logo, AIX, DB2, Domino, i5/OS, Lotus, Lotus Notes, LotusScript, Notes, Sametime, 

WebSphere, and z/OS are trademarks or registered trademarks of IBM Corporation in the United States, 

other countries, or both.


Additional IBM copyright information can be found at: http://www.ibm.com/legal/copytrade.shtml


Microsoft, Windows, and the Windows logo are trademarks of Microsoft Corporation in the United States, 
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other countries, or both. 

UNIX is a registered trademark of The Open Group in the United States and other countries. 

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun

Microsystems, Inc. in the United States, other countries, or both.


Intel and Pentium are trademarks of Intel Corporation in the United States, other countries, or both.


Other company, product, or service names may be trademarks or service marks of others.
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